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1 Introduction 

1.1 Description 

This document describes the installation and operation of the Quasonix Rack-Mount RDMSTM Telemetry Receiver. 

The RDMS™ (Receiver / DeModulator / bit Synchronizer) is designed to downconvert, demodulate, and bit synch 

to a variety of RF telemetry signals from flight-test aircraft. With an intuitive front-panel interface as well as an 

extensible Ethernet-based client interface, and antenna-tracking outputs, the Rack-Mount RDMSTM is capable of 

fulfilling a variety of flight test station requirements. 

The following waveform formats are supported by RDMS™: 

• PCM/FM (ARTM Tier 0) 

• SOQPSK-TG (ARTM Tier I) 

• ARTM CPM / Multi-h CPM (ARTM Tier II) 

• Legacy (PSK) suite, which includes: 

• BPSK 

• QPSK 

• Offset QPSK (OQPSK) 

• Asymmetric QPSK (AQPSK) 

• Unbalanced QPSK (UQPSK) 

• Asymmetric Unbalanced QPSK (AUQPSK) 

• Digital PM 

Of the aforementioned, RDMS™ provides true multi-symbol trellis demodulation in all three ARTM modes, 

PCM/FM, SOQPSK-TG, and Multi-h PCM. It also provides a clock signal, obviating the need for any outboard bit 

synchronizer. 

The Rack-Mount RDMS™ Telemetry Receiver is manufactured by: 

 

Quasonix, Inc. 
6025 Schumacher Park Drive 

West Chester, OH 45069 
CAGE code: 3CJA9 

 

1.2 Nomenclature 

The Rack-Mount RDMS™ (hereafter referred to as “RM RDMS™”) is available in a plethora of variations based on 

the number of channels, frequency bands, demodulation methods, options, etc. The features and modes installed in 

each unit are identified in the model number, as depicted in Figure 1. 
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Figure 1: Rack-Mount RDMS™ Part Number Construction 

 

1.2.1 Band 

Band field codes are listed in Table 1. 

 

Table 1: Standard Band Field Codes 

Model Number 
Code 

Band Minimum 
Frequency 

Maximum 
Frequency 

Default 
Frequency 

P P band (UHF) 400.0 MHz 1150.0 MHz 400.0 MHz 

L Lower L 1435.5 MHz 1534.5 MHz 1435.5 MHz 

U Upper L 1755.0 MHz 1850.0 MHz 1755.0 MHz 

S S 2200.5 MHz 2394.5 MHz 2200.5 MHz 

C C “Low” 4400.0 MHz 5150.0 MHz 4400.0 MHz 

G P and S (Dual band) 400.0 MHz and 
2200.5 MHz 

1150.0 MHz and 
2394.5 MHz 

2200.5 MHz 

F S and C (Dual band) 2200.5 MHz and 
4400.0 MHz 

2394.5 MHz and 
5150.0 MHz 

2200.5 MHz 

M Lower L, Upper L, and 
S (Tri-band) 

1435.5 MHz 2394.5 MHz 1435.5 MHz 

R P, Full-L, and S 

(Quad band) 

400.0 MHz 2394.5 MHz 1435.5 MHz 

Q Full L, S, and C 

(Quad band) 

1435.5 MHz 5150.0 MHz 1435.5 MHz 

- - X2

Copy Channel 1 modes
(both channels 

configured the same) 
(X2 or blank)

Rack Mount RDMS™  Part Numbering Example

S

Frequency 
Band Code 
(Refer to 

band tables)

QSX-RDMS-RM 2

Standard 
Prefix

Channels 
1 or 2

- - XF

Options, separated by 
hyphens

(example extended 
frequency)

M

Frequency 
Band Code
(if different 
Channel 2)
(Refer to 

band tables)

-1 1 1 0

P
CM

/FM

SO
Q

P
SK-TG

Le
gacy

Mode:
 1 = Enabled

0 = Not enabled

A
R

TM
 CP

M

1 1 1 0

P
CM

/FM

SO
Q

P
SK-TG

Le
gacy

Mode:
 1 = Enabled

0 = Not enabled
(if different 
Channel 2)

A
R

TM
 CP

M

-
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Model Number 
Code 

Band Minimum 
Frequency 

Maximum 
Frequency 

Default 
Frequency 

E P, Full L, S, and C 

(Five band) 

400.0 MHz 5150.0 MHz 400.0 MHz 

 

1.2.2 Options 

The available options are listed below. Refer to section 1.2.3 for detailed descriptions of each option. Please contact 

Quasonix for assistance ordering receiver options. 

• 14 14 SAW filters (adds 70 kHz, 1.4, 3, 6, 14, and 28 MHz filters) 

• CT Continuous tuning 

• DC Digitally implemented pre-detection diversity combiner (requires dual-channel configuration) 

• K7 K7 Viterbi Decoder (k=7, rate 1/2) 

• LD LDPC decoder 

• ND Blank front panel with no displays or keypad 

• RS RS-422 clock and data outputs on 3-lug triax connectors 

• X2 Configure-Channel 2 the same as Channel 1 (bands and modes) 

• XC Extended C band 

• XF Extend frequency range for all enabled bands 

• XL Extended Lower L band 

• XP Extended P band 

• XS Extended S band 

• XU Extended Upper L band 

For example, a model QSX-RDMS-RM2-L-1101-S-1101-DC is configured as shown in Table 2: 

 

Table 2: Model Configuration Example 

Identifiers Description 

QSX Quasonix product 

RDMS Receiver / Demodulator / Bit Synchronizer 

RM2 Rack-Mount package, 2 channels 

L Ch 1: Lower L-band operation 

1101 Ch 1: Tier 0 present, Tier I present, Tier II absent, 
Legacy (PSK) present 

S Ch 2: S-band operation 

1101 Ch 2: Tier 0 present, Tier I present, Tier II absent, 
Legacy (PSK) present 
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Identifiers Description 

DC Diversity combiner option 

 

In the case of multi-channel receiver configurations with identical frequency bands and modes, a shorthand part 

number can be used by including a multiplier code immediately following the initial frequency band and mode 

character string. The multiplier code is “X2” for applicability to a two channel receiver configuration. 

As an example, the following traditional part number, QSX-RDMS-RM2-M-1110-M-1110-DC, can be shortened to 

QSX-RDMS-RM2-M-1110-X2-DC. 

1.2.3 Detailed Option Descriptions 

1.2.3.1 SAW Filter Option – 14 

This option adds additional SAW filters, for a total of 14. The additional filters are 70 kHz, plus 1.4, 3, 6, 14, and 28 

MHz. 

1.2.3.2 Continuous Tuning – CT 

The CT option allows continuous tuning, including between specified bands. This option only applies to five-band 

receivers. 

1.2.3.3 Diversity Combiner – DC 

The DC option provides a digitally implemented pre-detection diversity combiner. This option requires the dual-

channel configuration. 

1.2.3.4 Viterbi Decoder (for Legacy PSK Only) – K7 

The K7 option (k=7, rate 1/2) enables Viterbi decoding of a convolutionally encoded data stream, which converts it 

back to the original (uncoded) source data stream. 

Convolutional encoding adds redundant information to the transmitted data stream to help detect and correct bit 

errors that may occur, particularly due to predominantly Gaussian noise. Use of convolutional encoding requires a 

matching Viterbi decoder in the receiver to extract the source data. The decoded data rate is half the encoded data 

rate. The receiver has two independent decoders, one for in-phase (“I”) data and one for quadrature (“Q”) data. For 

BPSK, only a single decoder is used. Each decoder is compatible with the convolutional encoding described in the 

“Consultative Committee for Space Data Systems, Recommendation for Space Data System Standards, TM 

Synchronization and Channel Coding, CCSDS 131.0-B-1, Blue Book, September 2003, Section 3.” 

1.2.3.5 Forward Error Correction/Low Density Parity Check (LDPC) (SOQPSK Only) – LD 

The LD option provides the Low Density Parity Check (LDPC) forward error correction (FEC) decoder. This option 

is only available with SOQPSK. 

1.2.3.6 No Display – ND 

The ND option provides a blank front panel with no displays or keypad. 

1.2.3.7 RS-422 – RS 

The RS option specifies RS-422 clock and data outputs on 3-lug triax connectors. 

1.2.3.8 Clone Channel 2 – X2 

The X2 option specifies Channel 2 configuration to match the Channel 1 bands and modes. 
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1.2.3.9 Extended C Band – XC 

The XC option specifies a new frequency limit for C band receivers. The standard frequency range for C band is 

4400.0 MHz to 5150.0 MHz. The extended tuning range is 4400.0 MHz to 5250.0 MHz. 

1.2.3.10 Extended Frequency All Bands – XF 

The XF option specifies extended frequency ranges for all enabled bands. Refer to Table 3 for extended ranges. 

 

Table 3: Extended Band Frequency Ranges 

Band Standard Frequency 
Range 

Extended Frequency 
Range 

P band (UHF) 400.0 MHz – 1150.0 MHz 200.0 MHz – 1150.0 MHz 

Lower L 1435.5 MHz – 1534.5 MHz 1415.0 MHz – 1585.0 MHz 

Upper L 1755.0 MHz – 1850.0 MHz 1650.0 MHz – 1855.0 MHz 

S 2200.5 MHz – 2394.5 MHz 2185.0 MHz – 2500.0 MHz 

C 4400.0 MHz – 5150.0 MHz 4400.0 MHz – 5250.0 MHz 

 

1.2.3.11 Extended Lower L Band – XL 

The XL option specifies a new frequency limit for Lower L band receivers. The standard frequency range for Lower 

L band is 1435.5 MHz to 1534.5 MHz. The extended tuning range is 1415.0 MHz to 1585.0 MHz. 

1.2.3.12 Extended P Band – XP 

The XP option specifies a new frequency limit for P band receivers. The standard frequency range for P band is 

400.0 MHz to 1150.0 MHz. The extended tuning range is 200.0 MHz to 1150.0 MHz. 

1.2.3.13 Extended S Band – XS 

The XS option specifies a new frequency limit S band receivers. The standard frequency range for S band is 2200.5 

MHz to 2394.5 MHz. The extended tuning range is 2185.0 MHz to 2500.0 MHz. 

1.2.3.14 Extended Upper L Band – XU 

The XU option specifies a new frequency limit for Upper L band receivers. The standard frequency range for Upper 

L band is 1755.0 MHz to 1850.0 MHz. The extended tuning range is 1650.0 MHz to 1855.0 MHz. 

1.3 Package Contents 

The contents of the box include the following: 

• Rack-Mount receiver unit 

• Power cord 

• CD with user manual, data sheets, etc. 

• Four (4) rubber feet with adhesive for lab bench use 
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2 Specifications 

 

Characteristic Specification 

Receiver Section 

Type Dual-conversion superheterodyne 

Standard Input RF Frequency 

P band: 400.0 MHz – 1150.0 MHz 

Lower-L band: 1435.0 MHz – 1534.5 MHz 

Upper-L band: 1755.0 MHz – 1850.0 MHz 

S band: 2200.5 MHz – 2394.5 MHz 

C band: 4400.0 MHz – 5150.0 MHz 

P and S bands: 400.0 MHz – 1150.0 MHz and 

2200.5 MHz – 2394.5 MHz 

S and C bands: 2200.5 MHz – 2394.5 MHz and 

4400.0 MHz – 5150.0 MHz 

Tri band: Lower L, Upper L, S 

Quad band: Lower L, Upper L, P, and S 

Quad band: Lower L, Upper L, S, and C 

5-band: Lower L, Upper L, S, C, and P 

Tuning resolution 
Tunes in 62.5 kHz increments, to the 70 MHz IF output, after the 70 MHz IF output, 
receiver tunes in increments of less than 1 Hz 

Frequency stability 
1 ppm over temperature 

1 ppm per year aging 

Reference oscillator 20 MHz 

Noise figure 3.5 dB (typical), 5 dB (maximum) 

LO phase noise, measured at 70 MHz 
IF output 

-115 dBc/Hz @ 1 MHz offset 

Maximum RF input +20 dBm (+10 dBm for C-band) 

Available gain (to 70 MHz IF output) 114 dB 

Gain control 
128 dB control range 

User selectable: AGC or MGC (AGC freeze) 

AGC time constant Adjustable to any value from 0.1 ms to 1000 ms 

First IF bandwidth 60 MHz (nominal) 

IF rejection > 90 dB 

Image rejection 70 dB 

RF input impedance 50 ohms 

VSWR 3:1 Max; 2.5:1 Typical 
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Characteristic Specification 

Second IF Section 

IF frequency 70 MHz 

IF output level 0 dBm nominal (AGC mode) 

IF output impedance 50 ohms 

VSWR 2:1 Max; 1.5:1 Typical 

IF bandwidths 

250 kHz, 500 kHz, 1 MHz, 2 MHz, 4.5 MHz, 10 MHz, 20 MHz, 40 MHz. Automatic 
selection based on modulation type and data rate, with manual override. 

Optional: 70 kHz, 1.4 MHz, 3 MHz, 6 MHz, 14 MHz, 28 MHz 

Demodulator Section 

Demodulator type 

ARTM Tier 0 (PCM/FM), ARTM Tier I (SOQPSK-TG), ARTM Tier II (Multi-h CPM) 

Legacy suite: Analog FM, BPSK, QPSK, Offset QPSK (OQPSK), Asymmetric 
QPSK (AQPSK), Unbalanced QPSK (UQPSK), Asymmetric Unbalanced QPSK 
(AUQPSK), Digital PM 

Bit Rates 

Tier 0: 24 kbps to 23 Mbps in 1 bps steps 

Tier I: 100 kbps to 46 Mbps in 1 bps steps 

Tier II: 1 Mbps to 46 Mbps in 1 bps steps 

Legacy:  25 kbps to 20 Mbps in Analog FM, 50 kbps to 10 Mbps in BPSK, 

20 Mbps in QPSK in 1 bps steps 

Synchronization time 

(Average, at BER = 1e-5) 
Tier 0: 250 bits, Tier I: 385 bits, Tier II: 2,800 bits 

Synchronization threshold 

Tier 0: -8.0 dB  Eb/N0; RF Input (dBm): -118.0 (1 Mbps), -108.0 (10 Mbps) 

Tier I: -6.0 dB  Eb/N0; RF Input (dBm): -116.0 (1 Mbps), -106.0 (10 Mbps) 

Tier II: -7.0 dB  Eb/N0; RF Input (dBm): -117.0 (1 Mbps), -107.0 (10 Mbps) 

Sensitivity (BER = 1e-5) 

Tier 0:   8.6 dB  Eb/N0; RF Input (dBm): -101.4 (1 Mbps), -91.4 (10 Mbps) 

Tier I: 11.2 dB  Eb/N0; RF Input (dBm): -98.8 (1 Mbps),   -88.8 (10 Mbps) 

Tier II: 13.0 dB  Eb/N0; RF Input (dBm): -97.0 (1 Mbps),   -87.0 (10 Mbps) 

Bit Synchronizer Section 

Input codes NRZ-L/M/S, BIФ-L/M/S 

Output codes NRZ-L/M/S, BIФ-L/M/S 

Data and clock out TTL (BNC) or RS-422 (Triax) 

Lock detector out TTL 

Derandomizer Standard IRIG 15-stage polynomial, selectable On/Off 

Video Section 

Video out Dual wideband outputs, DC to 35 MHz 

Video filter bandwidth User programmable 

Output level 1 Vp-p nominal, 4 Vp-p maximum 

NTSC de-emphasis Selectable On/Off 

Environmental Section 

Operating Temperature 0°C to +50°C 

Non-operating Temperature 0°C to +70°C 

Operating Humidity 0 to 95% (non-condensing) 

Altitude Up to 30,000 ft. (with the no displays options) 
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Characteristic Specification 

Physical Section 

Size 
1U rack-mount chassis; 19” wide, 1.75” tall, 14-5/16” rack depth, 15-11/16” overall 
depth 

Weight 10.4 lbs. (dual-channel) 

Connectors – per RF channel 

RF In: Type-N female 

I Out, Q Out, Clock Out, Data Out, IF Out, AGC Out, AM Out: BNC female 

Status/SDI Out: DB-15 High Density female 

Connectors – combined channel Clock Out, Data Out, AGC Out, AM Out: BNC female 

Connectors – per chassis 

Ethernet: RJ-45 

Data: USB 

Programming: MDM-25 male 

Power 100 to 240 VAC, 50/60 Hz 
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3 Installation Instructions 

3.1 Mechanical 

The RM RDMS™ Telemetry Receiver’s enclosure fits in a standard 19” rack, occupying just 1U of rack space. 

Mechanical layouts are provided in Figure 4 and Figure 5. 

 

Figure 2: Mechanical Drawing – Front View 

 

 

 

Figure 3: Mechanical Drawing – Top View (Dual-channel Connectors Shown) 
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Figure 4: Interior 3-D Drawing of Single-Channel Receiver 

 

 

 

Figure 5: Portable 19” Rack Installation with Four RDMS™ Units Shown 
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3.2 Thermal 

The storage temperature of the RM RDMS™ unit is rated for 0°C to +70°C, while the operating temperature is rated 

for 0°C to +50°C. It is recommended that the unit be kept in a temperature controlled environment to minimize the 

risk of operating (or storing) outside the ranges specified. In particular, the four liquid crystal displays on the front 

panel are extremely sensitive to low temperatures. 

The RM RDMS™ features cooling vents on both sides of its aluminum chassis. These vents must be kept entirely 

unobstructed in order to allow for maximum airflow through the system. Whenever feasible, it is helpful to leave an 

open rack space above and below the RM RDMS™ for additional heat dissipation. 

3.3 Electrical 

The RM RDMS™ is available in single- or dual- channel configurations, with all pertinent electrical connections 

found on the rear panel. 

3.3.1 Rear Panel Connections 

Rear panel connectors are the same for all receivers; however, in a single-channel configuration all connectors are 

not active. 

An optional pre-detection diversity combiner is available in the dual-channel receiver configuration. Connectors for 

the diversity combiner are present whether the feature is ordered or not. The electrical interface connectors for all 

configurations are shown in Figure 6. 

 

 

Figure 6: Rear Panel 

 

Functional descriptions and electrical characteristics for each connector located on the rear panel are described in 

Table 4. 

 

Table 4: Rear Panel Connector Specifications 

Connector Function Electrical Characteristics Connector Type 

J1 1 I Out, video 50 ohms, DC coupled 

J2 1 Q Out, video 50 ohms, DC coupled 

J3 1 Clock Out 75 ohms, 3.3V TTL 

J4 1 Data Out  75 ohms, 3.3V TTL 

J5 1 AGC Out 1k ohms, DC coupled 
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Connector Function Electrical Characteristics Connector Type 

J6 1 AM Out 75 ohms, DC coupled 

J7 1 CH1 SDI, CH1 Lock Detect, CH1 Clock 
and Data B, Combiner Clock and Data B 

HD15 D-Sub 

J8 1 RF Input 50 ohm unbalanced 

J9 2 IF Out, 70 MHz 50 ohm unbalanced 

J10 1 IF Out, 70 MHz 50 ohm unbalanced 

J11 2 I Out, video 50 ohms, DC coupled 

J12 2 Q Out, video 50 ohms, DC coupled 

J13 2 Clock Out 75 ohms, 3.3V TTL 

J14 2 Data Out  75 ohms, 3.3V TTL 

J15 2 AGC Out 1k ohms, DC coupled 

J16 2 AM Out 75 ohms, DC coupled 

J17 2 CH2 SDI, CH2 Lock Detect, CH2 Clock 
and Data B 

HD15 D-Sub 

J18 2 RF Input 50 ohm unbalanced 

J19 Combined Clock Out 75 ohms, 3.3V TTL 

J20 Combined Data Out 75 ohms, 3.3V TTL 

J21 Combined AGC Out 50 ohms, DC coupled 

J22 Combined AM Out 50 ohms, DC coupled 

J23 Not 
Applicable 

Factory Use Only 25 pin Micro-D 

J24 Not 
Applicable 

Ethernet control Standard PC Ethernet 
port 

 

3.3.1.1 Channel 1 HD15 D-Sub Pinout 

The pinout for J7, the HD15 D-sub connector, is shown in Table 5. Pin locations are illustrated in Figure 7. 

 

Table 5: Channel 1 HD15 D-Sub Pinout (J7) 

Pin Electrical Char. Pin Electrical Char. Pin Electrical Char. 

1 SDI Out 6 GND 11 CH1 Clock D 

2 GND 7 CH1 Clock B 12 GND 

3 CH1 Demod Lock 8 GND 13 CH1 Data D 
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Pin Electrical Char. Pin Electrical Char. Pin Electrical Char. 

4 GND 9 CH1 Data B 14 GND 

5 CH1 Ones Detect 10 GND 15 N/C 

 

 

Figure 7: HD15 D-Sub Pin Locations 

 

3.3.1.2 Channel 2 HD15 Pinout 

The pinout for J17, the HD15 D-sub connector, is shown in Table 6. Pin locations are illustrated in Figure 7. 

 

Table 6: Channel 2 HD15 D-Sub Pinout (J17) 

Pin Electrical Char. Pin Electrical Char. Pin Electrical Char. 

1 CH SDI Out 6 GND 11 N/C 

2 GND 7 CH2 Clock B 12 N/C 

3 CH2 Demod Lock 8 GND 13 N/C 

4 GND 9 CH2 Data B 14 N/C 

5 CH2 Ones Detect 10 GND 15 N/C 

 

3.3.2 Electrical Signals 

By default, the output data is valid on the falling edge of the clock, as shown in Figure 8. The polarity of the output 

clock may be inverted by toggling the Clock Polarity setting in either user interface. The RM RDMS™ can be 

operated through its front panel interface or Ethernet-based remote client interface (Remote RDMS™ Client). 
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Figure 8: Baseband Signal Timing 

 

The RF input to the receiver is a 50 ohm interface. 

The RM RDMS™ also provides a 70 MHz IF output for each channel for troubleshooting purposes. The IF is 

resistively coupled from the input of the demodulator. Therefore, the signal level on the IF output should be within 2 

dB of the demodulator’s input. 

3.4 Remote Control Interface 

The receiver’s remote control interface, Remote RDMSTM Client (also referred to as “RRC”, or simply “the client”) 

is an Ethernet-based graphical user interface that enables configuration and monitoring of one, or multiple, RM 

RDMS™ units on the user’s network. The client provides easy-to-read, real-time status information to the user, thus 

eliminating the need for direct access to the front panel. 

RRC is built upon Microsoft’s ubiquitous .NET Framework, which is a software-based coding foundation that 

facilitates consistent application performance across various hardware platforms, as well as enhanced security. .NET 

is compatible with Windows XP, Windows Vista, and Windows 7. 

To install RRC from the accompanying CD: 

1. Go to the “Remote RDMS Client Install” folder at the root level of the CD. 

2. Double-click on the “Setup.exe” file and the installation will begin. 

Depending on the operating system, the user may receive an application install security warning that says the 

publisher cannot be verified. Click on the ‘Install’ screen button to continue. Toward the end of installation, the 

Windows firewall may ask the user if they wish to block the application. The user should click on ‘Unblock’ to 

enable the Remote RDMS™ Client. 

Following installation, the program can be found under the following Windows path: 

Start > All Programs > Quasonix Tools > Remote RDMS > Client 
 

Windows Vista and Windows 7 include .NET by default; however certain Vista users may still be prompted during 

the RRC installation process to install the latest version of .NET, which is included on the CD under the folder 

“Quasonix Client Dot Net Support”. 

Bit period

(360 deg)

User asserts data on rising edge

of TTL clock, rising edge of

ECL clock+ signal, or rizing

edge of TIA/EIA422 "A" clock

generator terminal

Clock jitter and data to clock

skew reference point

Tx  samples  DATA on

falling edge of TTL clock,

falling edge of ECLclock(+)

signal, or falling edge of

TIA/EIA422 "A" clock

terminal.

data=1 (MARK)

data=0 (SPACE)

CLOCK

NRZL

DATA

Baseband Signal Timing - 0 degree clock

data=1 (MARK)
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For issues that occur during installation, call Quasonix Technical Support at 513-942-1287. 

3.4.1 Network Requirements 

The following parameters are required for RRC to operate properly within a network: 

• Multicast must be enabled on the network level 

• Network or local firewalls must provide for a means to open up ports for the Remote RDMS™ Client to 

communicate with the receiver through the network, otherwise the software will not work properly 

Note: Certain real-time antivirus and firewall programs, such as Symantec’s Endpoint Protection, are known to 

block the ports used by the Remote RDMS™ Client application without alerting the user. Others, such as 

Microsoft’s Windows Built-in Firewall, alert the user of the action and allow for the decision to be overridden. If 

communications between the RRC and the rack unit are being disrupted by the user’s antivirus and firewall 

program, Quasonix recommends temporarily disabling it. 

If an inexpensive broadband router is used instead of a switch or hub to connect the computer and the rack unit, 

check each unit’s Ethernet cable connections to be sure that they are not connected to the WAN port on the 

broadband router. 

After the RRC has successfully established a connection, refer to your firewall documentation for allowing multicast 

and or RRC program access. The following IP and port addresses may be useful for troubleshooting firewall issues: 

RRC Multicast IP addresses and Ports: 
 

MULTICAST IP Address 224.168.200.1 

MULTICAST IP Address 224.168.200.2 

MULTICAST PORT 65000 

MULTICAST PORT 65001 

 

Graphical data broadcasting and advanced settings may require additional UDP ports to be opened. If you are 

experiencing problems with Advanced Settings in the ‘Selected RDMS Control’ dialog or with the ‘Selected RDMS 

Performance Monitoring’ dialog in the RRC program, then additional ports need to be opened. These additional 

ports can be found under ‘Tools > Network Settings’ in the RRC application. 

Note: These ports are based on the RDMS’ unique IP address; therefore a static IP address may be advisable if your 

DHCP server or device changes the IP address of the RDMS™. 
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4 Operating Instructions 

The RM RDMS™ can be operated through its front panel interface or via the Ethernet-based remote client interface 

(Remote RDMSTM Client). The client is capable of configuring, maintaining, and monitoring multiple receivers 

within a network. 

4.1 Front-Panel Control 

The Rack-Mount Receiver’s comprehensive front panel interface includes (4) 64k-color liquid crystal displays 

(LCDs) for displaying receiver status, configuration settings, and waveform graphics; individual function keys for 

the most common settings; and a complete numeric keypad for convenient parameter entry. 

In a single-channel configuration, waveform graphics are displayed on the left-most LCD and receiver settings are 

on the second LCD from the left. A static Quasonix logo is shown on the two right-most LCDs. 

In a dual-channel receiver, the two LCDs located to the left of the keypad are designated for Channel 1, while the 

other two LCDs are designated for Channel 2, as shown in Figure 9. The LCDs for Channel 2 are oriented such that 

the receiver settings are found on the left LCD—closest to the keypad—and the waveform graphics on the right 

LCD. 

 

 

Figure 9: Front Panel Diagram for Dual-Channel Configuration 

 

The front panel keypad is shown in Figure 10. 

 

 

Figure 10: Front Panel Keypad 
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4.1.1 Waveform Graphics 

Each channel’s waveform graphics display provides a real-time visual representation of the received signal’s 

constellation, or eye pattern in the case for PCM/FM. 

An example of a PCM/FM eye pattern, taken from a spectrum analyzer, is shown in Figure 11. 

 

 

Figure 11: Example PCM/FM Eye Pattern 

 

An example of an SOQPSK constellation is shown in Figure 12. 

 

 

Figure 12: Example SOQPSK Constellation 
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In addition to the eye pattern or constellation, the waveform graphics screen displays signal strength and signal 

quality in vertical bar graph form, a red line AGC Zero On indicator in the Signal Strength bar, and signal lock 

detect through a padlock icon, as shown in Figure 13. 

 

 

Figure 13: Waveform Graphics LCD with Locked PCM/FM Signal 

 

The signal strength bar, the left of the two with the letter “S” below it, is measured in dBm with an unspecified 

range of -120 dBm to +10 dBm. When a signal -100 dBm or higher is detected, the bar turns green to signify “good” 

signal strength. 

The measurement of strength from an incoming telemetry signal by itself does not provide enough information 

about the integrity of the received data. Therefore, the signal quality metric is displayed to the right of the signal 

strength bar, with “Q” below the graph. 

Signal quality is displayed as a unit-less metric with a range from 0 to 99. When the receiver locks onto a signal, the 

signal quality bar turns green. Otherwise, the bar is displayed in red. 

4.1.1.1 Signal Quality 

The Signal Quality indicator is derived from an estimate of the Signal-to-Noise Ratio (SNR) of the received signal. 

This estimate is calculated identically for all modes using one of two algorithms selected by the choice of SNR 

Estimator (refer to sections 4.1.5.22 and 4.2.3.1.2.9.4 for further details). 

4.1.2 Navigation 

The Rack-Mount Receiver’s traditional hierarchical menu structure is navigated using the arrow and Enter keys on 

the front panel keypad, as shown in Figure 14. 
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Figure 14: Front Panel Navigation Keys 

 

4.1.3 Selecting a Receiver Channel 

In a single-channel configuration all front panel keys are active for the receiver. In a dual-channel configuration, 

Channel 1 will be active upon start-up by default. To toggle control between the channels, press the Select Unit key 

on the front panel keypad. 

 

 

Figure 15: Select Unit Key 

 

The LCD dedicated to receiver settings that is under active control will feature a solid blue header bar and yellow 

text. The channel number displays in the top left hand corner of the screen. In Figure 16, “CH 1” designates channel 

1. 

 

 

Figure 16: Active Main Menu Settings LCD 

 

Meanwhile, the LCD(s) for an inactive receiver will feature a menu bar that is grayed out and text that displays in 

white, as shown in Figure 17. 
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Figure 17: Inactive Main Menu Display Grayed Out – Other Channel Active 

 

The Wait message, shown in Figure 18, displays whenever the RDMS™ is busy—generally when processing a 

command for longer than one second. This usually occurs during a Mode change or Ethernet configuration. 

 

 

Figure 18: Inactive Main Menu Display with Wait Message 

 

4.1.4 Main Menu Settings 

The available options from the Main Menu screen include the following: 

• Frequency 

• Mode 

• Bit Rate 

• Combiner (Diversity Combiner option only) 

• Frequency Diversity (Diversity Combiner option only) 

• Data 

• Clock 
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• Derandomizer 

• Force Break Lock (PSK modes only) 

• Modulation Scaling (PCM/FM mode only) 

• Modulation Persistence (PCM/FM mode only) 

• Differential Encoder (SOQPSK-TG mode only) 

• AGC Menu 

• AM Menu 

• Options Menu 

• Advanced Menu 

Note: Several of the Main Menu settings are also available via direct access function keys located to the left of the 

numeric keypad. These include Frequency (‘Freq’), Mode, and Bit Rate (‘Rate’). The front panel keypad is shown in 

Figure 19. Depending on the number of options provided with the RDMS™, some menu items may not display 

when the RDMS™ is powered on. To see additional LCD menu options, use the arrow keys to scroll up or down. 

The complete list redisplays continuously forward or backward, depending on which arrow key is pressed. 

 

 

Figure 19: Front Panel Keypad 

 

To change a setting or access a secondary menu, use the arrow keys to navigate to the parameter. Once highlighted, 

the Enter key prompts a secondary menu screen or a setting screen, or even change the setting itself if there are only 

two possible states. To back out of a sub-menu, press the Escape key, ‘Esc’ on the front keypad. 

4.1.4.1 Setting Frequency 

There are two methods available to the user to set the receiver’s frequency. The first one is to press the Freq key on 

the front panel keypad. The second method is to highlight the Frequency option on the Main Menu, then press the 

Enter key on the PC keyboard. 

 

 

Figure 20: Frequency Key on Front Panel 
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Figure 21: Main Menu, Frequency Setting 

 

Either method displays a frequency dialog screen prompting the operator to enter a frequency using the rack’s front 

panel keypad. 

 

 

Figure 22: Frequency Entry Screen 

 

The default frequency is highlighted. The user can use the front panel keypad to: 

a. Delete the entire number by pressing the left arrow key 

b. Move the cursor to the end of the number by pressing the right arrow key 

c. Begin typing the desired frequency, in MHz, using the numeric keypad 

For example, to set the frequency of an S-band receiver to 2250.5 MHz, press the following key combination: 

 

 

Figure 23: Example Keypad Combination for Setting Frequency 

 

The available center frequencies are based on the band(s) and any extended options that are ordered, as shown in 

Table 7. 
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Table 7: Band and Frequency Combinations 

Band Standard Frequency Range Extended Frequency Range 

P band (UHF) 400.0 MHz – 1150.0 MHz 200.0 MHz – 1150.0 MHz 

Lower L 1435.5 MHz – 1534.5 MHz 1415.0 MHz – 1585.0 MHz 

Upper L 1755.0 MHz – 1850.0 MHz 1650.0 MHz – 1855.0 MHz 

S 2200.5 MHz – 2394.5 MHz 2185.0 MHz – 2500.0 MHz 

C 4400.0 MHz – 5150.0 MHz 4400.0 MHz – 5250.0 MHz 

P and S (Dual band) 400.0 MHz – 1150.0 MHz and 
2200.5 MHz – 2394.5 MHz 

Refer to P and S ranges above 

S and C (Dual band) 2200.5 MHz – 2394.5 MHz and 
4400.0 MHz – 5150.0 MHz 

Refer to S and C ranges above 

Lower L, Upper L, and S 
(Tri-band) 

1435.5 MHz – 2394.5 MHz Refer to band ranges above 

P, Full-L, and S 

(Quad band) 

400.0 MHz – 2394.5 MHz Refer to band ranges above 

Full L, S, and C 

(Quad band) 

1435.5 MHz -5150.0 MHz Refer to band ranges above 

P, Full L, S, and C 

(Five band) 

400.0 MHz – 5150.0 MHz Refer to band ranges above 

 

4.1.4.2 Setting Mode 

To set the mode, or modulation, press the Mode key on the front panel keypad for a display of the available choices. 

Use the keypad arrows to navigate to the desired mode, and then press the Enter key. 

 

 

Figure 24: Main Menu, Mode Setting 
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Due to character limitations in the on-screen menu, some modulation names have been shortened. The following 

table lists the modes, as they will appear on the screen in the left column, with the generally accepted naming 

convention in the right column. 

 

Table 8: Modulation Naming Convention 

Screen Name Actual Name 

PCMFM PCM/FM 

SOQPSK SOQPSK-TG 

MhCPM Multi-h CPM / ARTM CPM 

BPSK BPSK 

QPSK QPSK 

AQPSK AQPSK 

AUQPSK AUQPSK 

OQPSK OQPSK 

UQPSK UQPSK 

DPM Digital PM 

SOQPSKLDPC SOQPSK with LDPC Decoder 

 

Note: Changing modes causes the receiver to reload the FPGA, which takes approximately 10 seconds to complete. 

A ‘Busy’ icon appears in the top right-hand corner of the front panel display screen to indicate that the unit is being 

re-configured. The unit is temporarily unavailable while the ‘Busy’ icon is present. 

4.1.4.3 Setting Bit Rate 

There are two methods available to the user to set the receiver’s bit rate. The first one is to press the Rate key on the 

front panel keypad. The second method is to highlight the Bit Rate option on the Main Menu, then press the Enter 

key on the PC keyboard. 

 

Figure 25: Rate Key on Front Panel 
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Figure 26: Main Menu, Bit Rate Setting 

 

Either method displays a bit rate dialog screen prompting the operator to enter a bit rate using the rack’s front panel 

numeric keypad, in Mbps. A decimal point is only needed for bit rates with fidelity down into the kilobits per second 

range. 

 

Figure 27: Bit Rate Entry Screen 

 

For example, to set the bit rate to 10 Mbps, press the following key combination: 

 

 

Figure 28: Example Keypad Combination for Setting Bit Rate 

 

If an out-of-range bit rate is entered, the maximum or minimum possible rate will be set by default. For instance, if 

the user attempts to set the bit rate to 50 Mbps in SOQPSK-TG mode, the receiver will default back to 46 Mbps, the 

highest possible rate in that particular mode. 

4.1.4.4 Diversity Combiner (Optional) 

A pre-detection diversity combiner is available as an option for dual-channel receivers. 

If diversity combining is installed on the RDMS™, it can be enabled through the Main Menu > Combiner option. 
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Figure 29: Main Menu, Combiner Setting 

 

When the combiner is enabled on one channel, the second channel will automatically reflect this change. 

Additionally, any parameter changes made by the user in one channel will automatically be made for the second 

channel, from which the combined signal is partially derived. The only setting that can still be changed individually 

when the diversity combiner is turned on is the channel frequency, which allows for frequency diversity to be 

implemented. To illustrate the synchronization of settings, the second channel’s settings menu highlight bar will 

mimic the navigation path being taken by the user in the first channel. 

Note: Whenever the Diversity Combiner is On, any changes made to the Frequency option (even with Frequency 

Diversity On enabled) causes Modulation Scaling for both channels to be set to the same value. However, if Mod 

Scaling was set to Locked when the Frequency was changed, Mod Scaling will change to Tracking. 

4.1.4.5 Frequency Diversity (Available with Diversity Combiner) 

The Frequency Diversity option allows the user to independently change the frequency of each channel when the 

diversity combiner is On. 

The FreqDiversity option is toggled On or Off using the Enter key on the front panel keypad. 

If there are two channels, the Combiner is set to On, and Frequency Diversity is Off, the channels are updated 

simultaneously. 

 

 

Figure 30: Main Menu, Frequency Diversity Setting 
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4.1.4.6 Setting Data Polarity 

The Data option on the Main Menu is for adjusting the data polarity. The parameter options are Normal and 

Inverted. To change the polarity, press the Enter key when the parameter is highlighted from the Main Menu. The 

default is Normal. 

 

 

Figure 31: Main Menu, Data Setting 

 

4.1.4.7 Setting Clock Polarity 

The Clock option on the Main Menu is for adjusting the clock polarity. The parameter options are Normal and 

Inverted. To change the polarity, press the Enter key on the front panel keypad when the parameter is highlighted on 

the Main Menu. The default is Normal. 

 

 

Figure 32: Main Menu, Clock Setting 

 

4.1.4.8 Derandomizer State 

The RM RDMS™ includes a derandomizer, which can be enabled (On) or disabled (Off) by selecting the parameter 

from the Main Menu and pressing the Enter key on the front panel keypad. The default setting for the derandomizer 

is Off. 
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Figure 33: Main Menu, Derandomizer Setting 

 

4.1.4.9 Force Break Lock (PSK Modes Only) 

The RDMS™ provides very rapid, robust synchronization. Nevertheless, it is possible that the demodulator declares 

a lock, yet the output data appears to be incorrect. This can happen when there is significant interference, for 

example. The Force Break Lock parameter allows the user to break the demodulator’s signal lock condition, forcing 

it to reacquire signal lock. 

To activate the Force Break Lock and reacquire a signal lock, use the down arrow key on the front panel keypad to 

scroll to the Force Break Lock. Press the Enter key to continue. 

 

 

Figure 34: Main Menu, Force Break Lock 

 

4.1.4.10 Modulation Scaling (PCM/FM Mode Only) 

Modulation Scaling is a method used to retain the maximum trellis coding gain of a non-ideal FM signal. There are 

four possible settings: Tracking, Locked, Off, or Acquire. 

4.1.4.10.1 Modulation Scaling - Tracking 

When the RDMS™ is powered on, the default setting is Tracking, unless the unit was powered off from a preset 

condition. If the unit was powered off from an unmodified preset setting, then the default condition of Modulation 

Scaling is as defined in the preset. When Tracking is set, the modulation scale index is actively being tracked. 

Note: The active setting is not saved when the rack is powered off, unless the Mod Persist option was set to On. 
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Frequency, mode, and bit rate changes, or any changes to a preset, cause the Modulation Scaling setting to revert 

back to Tracking. This is because the optimal signal monitoring is no longer valid. 

Note: Whenever the Diversity Combiner is On, any changes made to the Frequency option (even with Frequency 

Diversity On enabled) causes Modulation Scaling for both channels to be set to Tracking. 

 

  

Figure 35: Main Menu, Modulation 
Scaling – Tracking 

Figure 36: Red Eye Pattern Display - 
Tracking 

 

The graphing eye pattern is displayed in red when in Tracking mode. 

If there are two channels, and the Combiner is set to On, the Modulation Scaling controls for setting the modes are 

linked. In Acquire or Tracking mode, the actual scaling operation functions independently in each channel. 

4.1.4.10.2 Modulation Scaling - Locked 

When the RDMS™ has a good lock on the target transmitter, Modulation Scaling should be set to Locked by 

highlighting the Mod Scaling option on the Main Menu and then pressing the Enter key on the keypad. 

When Modulation Scaling is set to Locked, the graphing eye pattern is displayed in green, indicating the optimal 

modulation index is set. 

 

  

Figure 37: Main Menu, Modulation 
Scaling – Locked 

Figure 38: Green Eye Pattern Display 
- Locked 
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If Modulation Scaling is set to Locked, as shown in Figure 37, the active modulation scale index is also locked in on 

a particular setting. The modulation scale index number displays next to the Locked setting. 

If an index number was entered manually using the Mod Scale Index option (on the Mod Scaling Menu), 

Modulation Scaling is simultaneously changed to Locked and reflects the Index value set via the Mod Scaling 

Menu. 

Locked index numbers, manually or automatically selected, are lost when the Mod Scaling option is set to Tracking, 

Off, or Acquire. If the Locked index number is to be retained following a power-off cycle of the rack, then turn on 

the Mod Persist option via the Main Menu. Refer to section 4.1.4.11, Modulation Persistence. 

4.1.4.10.3 Modulation Scaling - Off 

The Mod Scaling Off setting is shown in Figure 39. When Modulation Scaling is set to Locked, the graphing eye 

pattern is displayed in green, indicating the optimal modulation index is set. 

 

  

Figure 39: Main Menu, Modulation 
Scaling – Off 

Figure 40: Green Eye Pattern Display 
- Off 

 

With Mod Scaling turned Off, the Mod Index is set to the optimal 0.700. Mod Scaling should be turned off when a 

new generation, digitally synthesized transmitter is the source. Digitally synthesized transmitters do not have a 

variable deviation sensitivity adjustment, and as such are not subject to inaccurate modulation index settings 

4.1.4.10.4 Modulation Scaling - Acquire 

Acquire mode has two states: Armed and Triggered. When Modulation Scaling is set to Acquire, in the absence of 

signal, the eye pattern will turn yellow, as shown in Figure 42, the state is set to Armed. In Armed state, modulation 

scaling operates continuously. 
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Figure 41: Main Menu, Modulation 
Scaling – Acquire 

Figure 42: Yellow Eye Pattern 
Display - Acquire 

 

If the receiver is locked and the delta h (the change in modulation index) has settled below the delta h threshold for 

the specified settling time, the state changes to Triggered, and the eye pattern will turn green. In Triggered mode, the 

estimated h (modulation index) is monitored but the scale is not updated. 

If delta h goes above the delta h threshold and settles again, the receiver is still locked, and the Eb/N0 at the settling 

point is higher than the last settling point, the current scaling is updated with the new estimate. There is no transition 

from Triggered back to Armed except for setting the mode to Acquire again. 

4.1.4.11 Modulation Persistence (PCM/FM Mode Only) 

The Mod Persist option allows the current state of the Mod Scaling setting to be retained following a power-off 

cycle of the rack. The default value is Off, as shown in Figure 43. 

 

 

Figure 43: Main Menu, Modulation Persistence – Off 

 

To retain a Locked index number, or to remain in Acquire mode, scroll to the Mod Persist option, then toggle the 

setting to On. 
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Figure 44: Main Menu, Modulation Persistence – On 

 

4.1.4.12 Differential Decoder 

In SOQPSK-TG mode, differential encoding and decoding eliminates the phase ambiguity inherent with the 

received data. The differential decoder can be enabled or disabled through the Main Menu by pressing Enter when 

the parameter is selected. The Enter key acts as a toggle switch. Normal SOQPSK operation requires the differential 

decoder to be On. 

 

 

Figure 45: Main Menu, Differential Decoder Setting 

 

4.1.4.13 AGC Menu 

Access the Automatic Gain Control (AGC) menu from the front panel Main Menu. Select the AGC Menu, and then 

press the Enter key on the front panel keypad. 
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Figure 46: Main Menu, AGC Menu Selection 

 

The AGC (Automatic Gain Control) menu includes the following parameters: 

• AGC state (On / Off) 

• Polarity (+ / -) 

• Gain (00) 

• Time Constant (in ms) 

• AGC Zero Hold (On / Off) 

• AGC Zero 

The user may toggle the AGC state, Polarity, and AGC Zero Hold values by highlighting the desired parameter and 

pressing the Enter key on the front panel keypad until the desired value displays. 

 

  

Figure 47: AGC Menu, AGC and Polarity Highlighted 
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Figure 48: AGC Menu, AGC Zero Hold Off Highlighted 

 

To change the Gain or Time Constant values, select Gain or Time Constant, then press the Enter key on the front 

panel. 

  

Figure 49: AGC Menu, Gain and Time Constant Highlighted 

 

A dialog screen displays prompting the operator to enter a new AGC Gain or Time Constant using the rack’s front 

panel numeric keypad. When the new value is entered, press the Enter key on the keypad. 

 

  

Figure 50: AGC Gain and Time Constant Entry Screens 

 

AGC Zero Hold causes the receiver to hold its zero setting, even if other parameters are changed. With AGC Zero 

Hold OFF, the receiver resets the AGC Zero value for any change of Mode, Bit Rate, or Frequency. 
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AGC Zero is used to set a baseline for background radio noise levels. The front panel displays provide visual 

indications whether the AGC is zeroed or not. If AGC Zero has not been set, the signal strength bar displays in 

yellow and lacks the red zero indication line, shown in Figure 51. 

 

 

Figure 51: Waveform Graphics Before AGC Zero Set 

 

A typical application of the AGC Zero function is explained in the following example. 

1. Connect the receiver to its normal RF signal source, such as antenna, LNA, cabling, and splitters. 

2. Orient the receiving antenna in a direction that is expected to yield the lowest signal level that the receiver 

is likely to encounter. 

3. Activate AGC Zero under this condition. (Scroll to AGC Zero, and then press the Enter key on the front 

panel, as shown in Figure 52.) 

4. An AGC Zero Set message briefly displays, as shown in Figure 53, to indicate AGC Zero is activated. 

5. After the AGC Zero is set, the signal strength bar changes from yellow to green, and a red line indicates the 

zero value set, as shown in Figure 54. 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

36  Quasonix, Inc. 

 

  

Figure 52: AGC Menu, AGC Zero Highlighted Figure 53: AGC Menu, AGC Zero Set Message 

 

 

 

Figure 54: Waveform Graphics After AGC Zero Set 

 

The AGC output voltage is set to zero volts DC at a time when the receiver input is at its minimum value. 

This process ensures that the AGC output voltage will not cross through zero volts DC under normal 

operation. 

4.1.4.14 AM Menu 

Access the Amplitude Modulation (AM) menu from the front panel Main Menu. Select AM Menu, then press the 

Enter key on the front panel keypad. 
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Figure 55: Main Menu, AM Menu Selection 

 

The AM (Amplitude Modulation) menu includes the following parameters: 

• Bandwidth (00) 

• Time Delay (0) 

• Polarity (+/-) 

• Scale (0.5-2.5) 

• AGC COMP (On / Off) 

To change the Bandwidth, Time Delay, or Scale values, select the appropriate option, as shown in Figure 56 and 

Figure 57, then press the Enter key on the front panel. 

 

  

Figure 56: AM Menu, Bandwidth and Time Delay Highlighted 
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Figure 57: AM Menu, Scale Highlighted 

 

A dialog screen displays prompting the operator to enter a new AM Bandwidth, Time Delay, or Scale using the 

rack’s front panel numeric keypad, as shown in Figure 58 and Figure 59. When the new value is entered, press the 

Enter key on the keypad. 

The AM Bandwidth can be set from 0.1 to 5 kHz 

The AM Scale has a range from 0.1 to 2.5. At its default setting of 1, the response is 2V p-p, into a 75 ohm load with 

a 50% AM. 

 

  

Figure 58: AM Bandwidth and Time Delay Entry Screens 

 

 

Figure 59: AM Scaling Entry Screen 
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The user may toggle the AM Polarity value by pressing the Enter key on the keypad. 

 

 

Figure 60: AM Menu, AM Polarity Highlighted 

 

The user may toggle the AGC COMP state by highlighting the AGC COMP and pressing the Enter key on the front 

panel keypad until the desired value displays. Refer to Appendix B for more information about the AGC COMP 

function. 

 

 

Figure 61: AM Menu, AGC COMP Highlighted 

 

4.1.5 Options Menu 

The Options Menu, which is accessed through the Main Menu, provides the following selections: 

• Save Rack Presets Menu 

• Load Rack Presets Menu 

• Save Rack Presets -> USB 

• Load Rack Presets <- USB 

• Save a USB Preset 1 

• Load a USB Preset 1 

• Status Menu 
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• Network Menu 

• LCD Backlight 

 

 

Figure 62: Main Menu, Options Menu Selection 

 

4.1.5.1 Save Rack Presets Menu 

The Save Rack Presets Menu allows the current settings to be saved for convenient retrieval at a later time, or for 

quickly switching between configurations. To save rack presets, select the appropriate option, as shown in Figure 

63, then press the Enter key on the front panel. 

 

 

Figure 63: Options Menu, Save Rack Presets Menu Selection 

 

The Save Presets screen, shown in Figure 64, provides eight (8) slots for saving presets. Use the Up and Down 

arrow keys to select a save slot with the message ‘Empty’. Pressing the ‘Enter’ key saves the current configuration 

in that slot. When a Save is successfully stored, the menu displays the message ‘Full’ next to the selected save slot. 
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Figure 64: Save Menu, Save Presets – Slot 1 Full, Slot 2 Empty 

 

To replace or remove an existing save slot, press the CLR key (Clear). After the CLR key is pressed, the display 

should show ‘Empty’ indicating the slot can be used again for saving a configuration. 

4.1.5.2 Load Rack Presets Menu 

The Load Menu allows previously stored configuration settings from the Save Rack Presets screen to be retrieved. 

To load saved rack presets, select the appropriate option, as shown in Figure 65, then press the Enter key on the 

front panel. 

 

 

Figure 65: Options Menu, Load Menu Selection 

 

The Load Presets screen, shown in Figure 66, displays eight (8) slots which may contain saved preset 

configurations. When a saved configuration file exists, the menu displays the message ‘Available’ next to the load 

slot. Use the Up and Down arrow keys to select a load slot with the ‘Available” message displayed. Pressing the 

Enter key loads the stored preset and configures the receiver accordingly. 
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Figure 66: Load Menu, Load Presets – Slot 1 Load Available, Slot 2 Empty 

 

4.1.5.3 Save Rack Presets to USB 

The Save Rack Presets to USB option allows the current rack presets (1 through 8) to be saved on a USB flash drive 

(memory stick) as a single profile. To save rack presets to a USB flash drive, select the appropriate option, as shown 

in Figure 67, then press the Enter key on the front panel. 

 

 

Figure 67: Options Menu, Save Rack Presets to USB Selection 

 

Insert a USB flash drive into the port on the front panel of the Rack-Mount RDMS™. 

A dialog screen displays prompting the operator to enter a number between 0 and 999 using the rack’s front panel 

numeric keypad, as shown in Figure 68. When the new value is entered, press the Enter key on the keypad. 

Any number may be used to identify rack preset configurations saved onto a USB flash drive (memory stick). If 

more than one configuration is saved, the number does not have to run sequentially, nor does it have to start at 0. For 

example, one preset configuration might be saved as 44 and another might be saved as 397. 

Another way of looking at this option is: An operator has saved any number of presets in slots 1 through 8 using 

the Save Rack Presets Menu described previously. Now the operator wants to save the complete set of presets for 

this rack onto a USB memory stick. The operator can save up to 1000 profiles (or sets of presets) for this rack (or 

any other racks) onto the same USB memory stick. Even if all 1000 profiles (1000 sets of 8 presets) were saved, 

they would still only take up about 112 MB of space on the USB stick. 
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If the number entered is already in use, the entry screen shown in Figure 69 displays. To overwrite the existing file, 

press the Enter key again. If the number was typed in error, press the Escape key on the keypad to cancel the Save. 

 

  

Figure 68: Save Rack Presets to USB 
Entry Screen 

Figure 69: File Exists Error Screen 

 

After successfully entering a preset number and pressing the Enter key, the Options Menu redisplays with one of 

two message boxes. If the presets saved successfully, the box shown in Figure 70 displays. It confirms the location 

and the name of the folder on the USB flash drive (memory stick). In this example, it is stored as profile 1. If there is 

no flash drive (memory stick) in the USB port on the front panel of the Rack-Mount RDMS™, the message in 

Figure 71 displays. Insert the flash drive into the USB port and redo the Save. 

 

  

Figure 70: Options Menu, Rack 
Presets Saved Message 

Figure 71: Options Menu, USB Error 
Message 

 

4.1.5.4 Load Rack Presets from USB 

The Load Rack Presets to USB option enables the user to select and load preset profiles (each profile is a set of 

specific rack presets 1 through 8) previously saved on a USB flash drive (memory stick). To load rack presets from a 

USB flash drive, select the appropriate option, as shown in Figure 72, then press the Enter key on the front panel. 
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Figure 72: Options Menu, Load Rack Presets from USB Selection 

 

Insert a USB flash drive into the port on the front panel of the Rack-Mount RDMS™. 

A dialog screen displays prompting the operator to enter a number between 0 and 999 using the rack’s front panel 

numeric keypad, as shown in Figure 73. When the new value is entered, press the Enter key on the keypad. 

 

 

Figure 73: Load Rack Presets to USB Entry Screen 

 

After successfully entering a preset number and pressing the Enter key, the Options Menu redisplays with one of 

two message boxes. If the presets loaded successfully, the box shown in Figure 74 displays. It confirms the location 

and the name of the folder on the USB flash drive (memory stick). In this example, it was stored as profile 1. If there 

is no flash drive (memory stick) in the USB port on the front panel of the Rack-Mount RDMS™, the message in 

Figure 75 displays. Insert the flash drive into the USB port and redo the Load. 
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Figure 74: Options Menu, Rack 
Presets Loaded Message 

Figure 75: Options Menu, USB Error 
Message 

 

4.1.5.5 Save a USB Preset 

The Save a USB Preset option allows up to 1000 presets to be saved on a USB flash drive (memory stick). This 

option is similar to the Save Rack Presets option but instead of saving 1 through 8 presets directly on the Rack-

Mount RDMS™, this option allows up to 1000 presets to be saved by saving externally to a USB flash drive 

(memory stick). To save a single preset to a USB flash drive, select the appropriate option, as shown in Figure 76, 

then press the Enter key on the front panel. 

 

 

Figure 76: Options Menu, Save a USB Preset Selection 

 

Insert a USB flash drive into the port on the front panel of the Rack-Mount RDMS™. 

A dialog screen displays prompting the operator to enter a number between 0 and 999 using the rack’s front panel 

numeric keypad, as shown in Figure 77. When the new value is entered, press the Enter key on the keypad. 

Any number may be used to identify rack preset configurations saved onto a USB flash drive (memory stick). If 

more than one configuration is saved, the number does not have to run sequentially, nor does it have to start at 0. For 

example, one preset configuration might be saved as 44 and another might be saved as 397. 

If the number entered is already in use, the entry screen shown in Figure 78 displays. To overwrite the existing file, 

press the Enter key again. If the number was typed in error, press the Escape key on the keypad to cancel the Save. 
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Figure 77: Save a USB Preset Entry 
Screen 

Figure 78: File Exists Error Screen 

 

After successfully entering a preset number and pressing the Enter key, the Options Menu redisplays with one of 

two message boxes. If the preset saved successfully, the box shown in Figure 79 displays. It confirms the location 

and the name of the folder on the USB flash drive (memory stick). In this example, it is stored as Preset 11. If there 

is no flash drive (memory stick) in the USB port on the front panel of the Rack-Mount RDMS™, the message in 

Figure 80 displays. Insert the flash drive into the USB port and redo the Save. 

 

  

Figure 79: Options Menu, USB Saved 
Message 

Figure 80: Options Menu, USB Error 
Message 

 

4.1.5.6 Load a USB Preset 

The Load a USB Preset option allows a numbered preset to be loaded from a USB flash drive (memory stick). This 

option is similar to the Load Rack Presets option but instead of loading a preset directly from preset list on the Rack-

Mount RDMS™, this option allows a preset to be loaded from an external source (a USB flash drive). To load a 

single preset from a USB flash drive, select the appropriate option, as shown in Figure 81, then press the Enter key 

on the front panel. 
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Figure 81: Options Menu, Load a USB Preset Selection 

 

Insert a USB flash drive into the port on the front panel of the Rack-Mount RDMS™. 

A dialog screen displays prompting the operator to enter a number between 0 and 999 using the rack’s front panel 

numeric keypad, as shown in Figure 82. When the value is entered, press the Enter key on the keypad. 

 

 

Figure 82: Load a USB Preset Entry Screen 

 

After successfully entering a preset number and pressing the Enter key, the Options Menu redisplays with one of 

two message boxes. If the preset loaded successfully, the box shown in Figure 83 displays. It confirms the location 

and the name of the folder on the USB flash drive (memory stick). In this example, it is stored as profile 1. If there is 

no flash drive (memory stick) in the USB port on the front panel of the Rack-Mount RDMS™, the message in 

Figure 84 displays. Insert the flash drive into the USB port and redo the Save. 
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Figure 83: Options Menu, USB Loaded 
Message 

Figure 84: Options Menu, USB Error 
Message 

 

4.1.5.7 Status Menu 

The Status Menu provides the software version number (e.g. 1.0.4.3), the FPGA version number (e.g. 43000202h), 

the firmware version number (e.g. S3 1.0.027), an error count, options for clearing the error count or saving the 

errors to an external USB flash drive, and an option allowing software updates via external flash drive. The latter is 

particularly useful when debugging receiver issues with the help of Quasonix technical support. 

 

 

Figure 85: Options Menu, Status Menu Selection 

 

4.1.5.7.1 Save Events 

To save the error information externally: 

1. Insert a USB flash drive into the USB port on the front panel. 
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Figure 86: Status Menu, Save Events – Mem Stick 

 

The Save Events ‘Mem Stick’ parameter message changes to Save Events ‘Ready’ a few seconds after a 

valid USB flash drive is inserted. 

2. When ‘Ready’ is displayed, select the parameter and press the Enter key on the front panel keypad. 

The parameter displays Save Events ‘Finished’ after the error information has successfully been saved. 

3. Remove the USB flash drive. 

4.1.5.7.2 Application Update 

This option allows application software updates to the RDMS™ unit without shutting down, etc. 

To update application software externally: 

1. Insert the USB flash drive containing the software update into the USB port on the front panel. 

 

 

Figure 87: Status Menu, App Update – Mem Stick 

 

If a new application is found on the USB flash drive, installation begins immediately. If no update software 

is found on the USB flash drive, a Not Found message displays, as shown in Figure 88. Replace the USB 

flash drive with one containing the correct application file. 

2. Remove the USB flash drive when the installation is complete. 
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Figure 88: Status Menu, App Update – Mem Stick - Not Found 

 

4.1.5.8 Network Menu 

The Network Menu, which is accessed through the Options Menu, as shown in Figure 89, provides all of the 

pertinent networking settings for the rack unit, including: 

• DHCP status (DHCP) 

• IP address (IP) 

• Subnet mask (Subnet) 

• Default gateway address (Gateway) 

• Set Group Security ID 

• Set Rack Alias 

 

 

Figure 89: Options Menu, Network Menu Selection 

 

Note: Unlike other options, changes made within the Network Menu are not executed until the user clicks on the 

Apply New Settings parameter, located just below the Set Rack Alias field, shown in Figure 90. Apply New Settings 

does not display unless a change to any of the Ethernet parameters is detected. 
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Figure 90: Network Menu, Apply New Settings Displayed 

 

4.1.5.8.1 DHCP 

The DHCP option, when enabled, allows for the rack unit to automatically receive an IP address from the local 

DHCP server. If DHCP is turned off, then the user must choose a valid IP address for the unit. 

 

 

Figure 91: Network Menu, DHCP Setting 

 

4.1.5.8.2 IP Address 

The IP address for the rack unit will either be assigned to it automatically through the use of DHCP, or it must be 

entered by the user. When choosing an IP address, it is critical that the address is unique; otherwise the unit will not 

operate within the network properly. It is strongly recommended that the user contact their network administrator to 

receive a reserved address for this purpose. 
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Figure 92: Network Menu, IP Setting 

 

4.1.5.8.3 Subnet Mask 

The subnet mask identifies the portion of the IP address used as a host identifier for the subnet in which the 

Quasonix rack unit participates. It is expressed in a quad-dotted decimal representation, just like the unit’s IP 

address. The most common subnet mask is 255.255.255.0, which means that the unit’s last 8-bit number (i.e. 0 

through 255) uniquely identifies it within its sub-network. 

 

 

Figure 93: Network Menu, Subnet Setting 

 

4.1.5.8.4 Default Gateway Address 

This parameter is currently not used. It is intended for future applications that may require Internet or other gateway 

access. Contact your network administrator for the correct gateway address. 
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Figure 94: Network Menu, Gateway Setting 

 

4.1.5.8.5 Set Group Security ID 

RDMS™ racks may be configured two different ways, depending on the preferred structure. A Group Identifier (ID) 

is used to provide a unique name for each RDMS™. In the first configuration, racks may be named based on 

department, such as Lab, Development, Production, Demonstration, etc. In the second configuration, racks may be 

named for independent users, such as Office1, B4Btest, TestX, etc. 

The Set Group Security ID option is located on the Network Menu, as shown in Figure 95. The Group ID can only 

be set using this front panel menu. 

 

 

Figure 95: Network Menu, Set Group Security ID Setting 

 

When the Set Group Security ID option is selected, a Network Menu dialog box displays. If you want this rack to 

be publicly accessible, leave this entry blank or clear any previous entry using the Clr button on the front panel of 

the rack. 

To add a new Group ID, type a name (up to 16 characters A-Z and/or 0-9). The Up and Down arrow buttons are 

used to select alpha characters A~Z and the right arrow button is used to advance to the next cursor position. Use the 

numeric buttons to add numbers to the Group ID. Press the Enter button to accept changes. Repeat this step to add 

or clear additional Group IDs. 
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Figure 96: Enter New Group ID 

 

4.1.5.8.6 Set Rack Alias 

This optional parameter is used to provide an alternative name to a rack in addition to the IP Address. The default 

alias name is RDMS. When using the Multiple RDMS™ Performance Monitor (refer to Section 4.2.4.1), the alias 

can be used to quickly identify a particular rack in the displayed list. Examples of a rack alias might be 

“RDMSLab1”, “TestLabLevel4”, or “XYZProjectRDMS”. 

The Set Rack Alias option is located on the Network Menu, as shown in Figure 97. The Rack Alias may be set using 

this front panel menu or via the Remote RDMS™ Client, Network Settings window (refer to section 4.2.5.1). 

 

 

Figure 97: Network Menu, Set Rack Alias Setting 

 

To add a new rack alias, type a name (up to 16 characters A-Z and/or 0-9). The Up and Down arrow buttons are 

used to select alpha characters A~Z and the right arrow button is used to advance to the next cursor position. Use the 

numeric buttons to add numbers to the rack alias. Press the Enter button to accept changes. Repeat this step to add 

or clear additional rack aliases. 
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Figure 98: Enter New Rack Alias 

 

4.1.5.9 LCD Backlight Option 

The LCD Backlight option, shown in Figure 99, is used to adjust the lighting on the front panel display screens. This 

allows the displays to be easily seen no matter what the lighting conditions in the area where the rack is being used. 

To change the LCD Backlight value, select LCD Backlight, then press the Enter key on the front panel. 

 

 

Figure 99: Options Menu, LCD Backlight Selection 

 

A dialog screen displays, as shown in Figure 100, prompting the operator to enter a new LCD Backlight value using 

the rack’s front panel numeric keypad. When the new value is entered, press the Enter key on the keypad. 

 

 

Figure 100: LCD Backlight Value Entry Screen 
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4.1.5.10 Advanced Menu 

The Advanced Menu should only be accessed by advanced users. Contact Quasonix customer support before using 

these options. 

The Advanced Menu, which is accessed via the Main Menu, as shown in Figure 101, provides access to the 

following options: 

• Sync Measured Bit Rate 

• IF Filter 

• Video Filter 

• Video Scale 

• Video Invert 

• Video DeEmphasis 

• Phase Noise Compensation 

• Tape Output 

• Tape Frequency 

• Muting 

• Muting Timeout 

• Mod Scaling Menu 

• Encoding Menu 

• Convolutional Decode 

• SNR Estimator 

• Factory Default 

 

 

Figure 101: Main Menu, Advanced Menu 
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4.1.5.10.1 Synchronize Measured Bit Rate 

Synchronize Measured Bit Rate sets the receiver’s commanded bit rate to the value it is currently measuring on the 

input signal. The purpose of this process is to eliminate unintended bit rate offset error so that the receiver can make 

full use of its bit synchronizer tracking range, or optionally reduce its tracking range. For the receiver to have an 

accurate measurement, however, the input signal must be close enough to the previously commanded bit rate to be 

within the current bit synchronizer lock range and actually be locked. 

The Sync Measured Bit Rate option is located on the Advanced Menu, as shown in Figure 102. This option may be 

set using this front panel menu or via the Remote RDMS™ Client, Advanced Settings window (refer to section 

4.2.5.1). 

 

 

Figure 102: Advanced Menu, Sync Measured Bit Rate Selection 

 

To apply a new measured bit rate, use the value displayed in the entry screen or, type a number using the numeric 

buttons. The right arrow button is used to advance to the next cursor position. Allowable value ranges vary 

depending on the waveform mode in use. Press the Enter button to accept changes. Repeat this step to apply a 

different measured bit rate. 

A signal lock must be present for this entry screen to display. If there is no signal lock, the message shown in Figure 

104 displays. 

 

 

Figure 103: Advanced Menu, Measured Bitrate Entry Screen 
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If the input signal is not close enough to the previously commanded bit rate to be within the current bit synchronizer 

lock range and the signal is not locked, a message box displays, as shown in Figure 104. 

 

 

Figure 104: Sync Measured Bit Rate Not Valid Message 

 

4.1.5.10.2 IF Filter 

The receiver’s integrated IF filter module, shown in Figure 105, includes eight (8) SAW filters, ranging in 

bandwidth from 250 kHz to 40 MHz in approximately one-octave steps. The standard eight filters are 250 kHz, 500 

kHz, 1 MHz, 2 MHz, 4.5 MHz, 10 MHz, 20 MHz, and 40 MHz. These filters serve as anti-aliasing filters ahead of 

the A/D converter in the demodulator itself. In addition, they can provide an added measure of adjacent channel 

interference rejection. 

 

 
 

Figure 105: 70 MHz IF Module in 2” x 3” Chassis 
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The measured responses of the eight filters are shown in Figure 78 and Figure 79 (note the change of horizontal 

scale between the two figures). 

Six additional filters are available allowing for a total of 14. The optional filters are 70 kHz, 1.4 MHz, 3 MHz, 6 

MHz, 14 MHz, and 28 MHz. The measured responses of the optional filters are shown in Figure 80 and Figure 81. 

Contact Quasonix for information about the optional filters. 

 

  

  
 

Figure 106: 70 MHz IF Module in 2” x 3” Chassis SAW Filter Responses, Narrow Group (10 MHz Span) 
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Figure 107: SAW Filter Responses, Wide Group (Plotted on 100 MHz Span) 
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Figure 108: Optional SAW Filter Responses for 70 kHz to 6 MHz 
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Figure 109: Optional SAW Filter Responses for 14 MHz and 28 MHz 

 

Based on the receiver’s high level of integration, the proper IF filter is automatically selected based on the current 

mode and bit rate settings of the demodulator. Although manual filter selection is available through the Advanced 

Terminal window in the RDMS™ client, or via the IF Filter Menu on the front panel LCD, as shown in Figure 110, 

manual selection is not recommended. In the case of a receiver with diversity combining enabled, the two 

channels must have the same IF filter selected for proper operation. 

 

  

Figure 110: Front Panel Advanced Menu and IF Filter Menu 

 

4.1.5.10.3 Video Filter 

The Video Filter option, available in PCM/FM mode, sets the system bandwidth for the analog signal. Nominally, 

NTSC color video is approximately 6 MHz in bandwidth and black and white is 4 MHz. This setting allows the user 

to control the cutoff of the video band pass. 

Note: Operating the receiver in analog mode is mutually exclusive with operating it as a digital receiver. The bit rate 

for the digital receiver and the video filter cannot be set independently of one another. 
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The Video Filter option, shown in Figure 111, is used to set the video filter value. 

To change the Video Filter setting, select the Video Filter option, then press the Enter key on the front panel. 

 

 

Figure 111: Advanced Menu, Video Filter Selection 

 

A dialog screen displays prompting the operator to enter a new video filter setting using the rack’s front panel 

numeric keypad. The Video Filter Setting Entry screen is shown in Figure 112. When the new value is entered, press 

the Enter key on the keypad. 

 

 

Figure 112: Video Filter Setting Entry Screen 

 

4.1.5.10.4 Video Scale 

The Video Scale option sets the peak-to-peak amplitude on the video outputs. By default the video output is 1 V 

peak-to-peak using a standard deviated NTSC video signal. This setting allows the user to compensate for a system 

where this is not the case. 

The Video Scale option, shown in Figure 113, is used to set the video scale value. 

To change the Video Scale setting, select the Video Scale option, then press the Enter key on the front panel. 
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Figure 113: Advanced Menu, Video Scale Selection 

 

A dialog screen displays prompting the operator to enter a new video scale setting using the rack’s front panel 

numeric keypad. The Video Scale Entry screen is shown in Figure 114. When the new value is entered, press the 

Enter key on the keypad. 

 

 

Figure 114: Video Scale Entry Screen 

 

4.1.5.11 Video Invert 

In Tier 0 (PCM/FM), the “Q” channel output of the RDMS delivers the demodulated FM output. Enabling the Video 

Signal Invert option inverts the FM output. 

The Video Invert option, shown in Figure 115, is used to set the video invert value to On or Off. 
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Figure 115: Advanced Menu, Video Invert Selection 

 

The user may toggle the Video Invert value by pressing the Enter key on the front panel keypad until the desired 

value displays. 

4.1.5.12 Video DeEmphasis 

The Video DeEmphasis option, shown in Figure 116, is used to set the Video DeEmphasis value to On or Off. This 

option should be used when a corresponding video pre-emphasis filter is used on the video transmit side. 

 

 

Figure 116: Advanced Menu, Video DeEmphasis Selection 

 

The user may toggle the Video DeEmphasis value by pressing the Enter key on the front panel keypad until the 

desired value displays. 

4.1.5.13 Phase Noise Compensation 

The Phase Noise Comp option, shown in Figure 117, is used to set the Phase Noise Compensation value to On or 

Off. 
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Figure 117: Advanced Menu, Phase Noise Compensation Selection 

 

The user may toggle the Phase Noise Compensation value by pressing the Enter key on the front panel keypad until 

the desired value displays. 

4.1.5.14 Tape Output 

The Tape Output option, shown in Figure 118, is used to set the Tape Output value to On or Off. 

 

 

Figure 118: Advanced Menu, Tape Output Selection 

 

The user may toggle the Tape Output value by pressing the Enter key on the front panel keypad until the desired 

value displays. 

The tape output signal appears on the I Out Video output for the corresponding channel. Please refer to section 3.3.1 

for a complete description of back panel connectors, including pinouts. 

4.1.5.15 Tape Frequency 

The Tape Frequency option, shown in Figure 119, is used to enter a tape frequency value (in MHz). The valid 

frequency range is 0.000 MHz to 20.000 MHz. 

To change the Tape Frequency value, select the Tape Freq option, then press the Enter key on the front panel. 
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Figure 119: Advanced Menu, Tape Frequency Selection 

 

A dialog screen displays prompting the operator to enter a new Tape Frequency value using the rack’s front panel 

numeric keypad. The Tape Frequency Value Entry screen is shown in Figure 120. When the new value is entered, 

press the Enter key on the keypad. 

 

 

Figure 120: Tape Frequency Value Entry Screen 

 

4.1.5.16 Muting 

The Muting option, shown in Figure 121, is used to set the muting value to On or Off. When the Muting option is set 

to On, the receiver stops sending clock and data information when the timeout value is reached. This option is 

beneficial to someone using a recorder with limited space. For example, if data is not locked to a valid signal or is 

outside the valid range, the information is muted (stopped) so the recorder is not filled with bad data. 
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Figure 121: Advanced Menu, Muting Selection 

 

The user may toggle the Muting value On or Off by pressing the Enter key on the front panel keypad until the 

desired value displays. 

4.1.5.17 Muting Timeout 

The Muting Timeout option, shown in Figure 122 is used to set a timeout value (in milliseconds). This setting is 

used to determine when to mute (stop sending data) when the Muting option is set to On. 

 

 

Figure 122: Advanced Menu, Muting Timeout Selection 

 

A dialog screen displays prompting the operator to enter a new Muting Timeout value (in milliseconds) using the 

rack’s front panel numeric keypad. The valid range is 0 to 46016 milliseconds. The Muting Timeout Entry screen is 

shown in Figure 123. When the new value is entered, press the Enter key on the keypad. 
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Figure 123: Muting Timeout Entry Screen 

 

4.1.5.18 Modulation Scaling Menu 

Access the Mod Scaling menu from the Advanced Menu. Select ‘Mod Scaling Menu’, as shown in Figure 124, then 

press the Enter key on the front panel keypad. 

 

 

Figure 124: Advanced Menu, Mod Scaling Menu Selection 

 

The Mod Scaling menu includes the following parameters: 

• Mod Scale Index 

• Hold Threshold (in dB) 

4.1.5.18.1 Mod Scale Index 

The Mod Scale Index option allows the operator to manually set the modulation scale index. This enables the 

receiver to operate at the optimum range of modulation desired by the user. 

When modulation scale index is set (via the Mod Scaling Menu, Mod Scale Index option, shown in Figure 125), the 

Modulation Scaling option (on the front panel Main Menu) is simultaneously changed to Locked. The Locked 

notation includes the new index number that the operator has chosen (shown in Figure 37). 

If the Locked index number is to be retained following a power-off cycle of the rack, then turn on Mod Persist from 

the Main Menu. Refer to section 4.1.4.11, Modulation Persistence. 

To change the Modulation Scale Index, select Mod Scale Index, then press the Enter key on the front panel. 
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Figure 125: Mod Scaling Menu, Mod Scale Index Selection 

 

A dialog screen displays prompting the operator to enter a new modulation scale index using the rack’s front panel 

numeric keypad. The Index Entry screen is shown in Figure 126. When the new value is entered, press the Enter key 

on the keypad. 

 

 

Figure 126: Modulation Scale Index Entry Screen 

 

To clear any locked modulation scale index number, go to the Main Menu and toggle the Mod Scaling option back 

to Tracking. After Mod Scaling is set to Tracking, the modulation index follows the receiver's present estimate of 

the mod index. 

4.1.5.18.2 Hold Threshold 

When Mod Scaling is in Tracking mode, the modulation index estimate becomes poorer as the signal-to-noise ratio 

(SNR) decreases (that is, as the received signal gets weak). This in turn negatively impacts demodulation 

performance, making bit errors more likely than they would be if the modulation index were known a priori. The 

purpose of the Hold Threshold is to set an SNR level (technically Eb/N0* level) below which the modulation index 

estimate will hold rather than track, so it does not get perturbed by noise. 

• Eb/N0 is the ratio of signal energy per bit (Eb) to noise energy spectral density (N0), which is sometimes 

referred to as “SNR per bit”. 
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Figure 127: Mod Scaling Menu, Hold Threshold Selection 

 

A dialog screen displays prompting the operator to enter a new modulation scale hold threshold using the rack’s 

front panel numeric keypad. The Mod Scale Hold Threshold Entry screen is shown in Figure 128. The allowable 

range is -20.000 to +30.000. When the new value is entered, press the Enter key on the keypad. 

 

 

Figure 128: Modulation Scaling Hold Threshold Entry Screen 

 

4.1.5.19 Encoding Menu 

Access the Encoding menu from the Advanced Menu. Select ‘Encoding Menu’, shown in Figure 129, then press the 

Enter key on the front panel keypad. 
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Figure 129: Advanced Menu, Encoding Menu Selection 

 

The Encoding menu includes the following parameters: 

• Encoding 

• Spectrum (On/Off) 

• Bi-Phase (On/Off) 

4.1.5.19.1 Encoding 

The Encoding option is used to set the non-return to zero (NRZ) value used by the receiver. NRZ is a way of 

encoding binary data on a physical signal. The options are: 

• NRZ-L – Non-return to zero Level 

• NRZ-M – Non-return to zero Mark (1) 

• NRZ-S – Non-return to zero Space 

The user may scroll through the Encoding options by pressing the Enter key on the front panel keypad until the 

desired value displays. 

 

 

Figure 130: Encoding Menu, Encoding Selection 
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4.1.5.19.2 Spectrum Inversion 

The Spectrum Inversion option inverts the frequencies processed by the demodulator relative to how they appear at 

the IF Output port. That is, low frequencies within the IF Filter bandwidth become high frequencies within the 

demodulator and vice versa. This can be used to compensate for a frequency inversion elsewhere in the system. 

 

 

Figure 131: Encoding Menu, Spectrum Selection 

 

The user may toggle the Spectrum Inversion value by pressing the Enter key on the front panel keypad until the 

desired value (On or Off) displays. 

4.1.5.19.3 Bi-Phase 

Bi-Phase encoding enables the demodulator to process Bi-Phase encoded data (as opposed to NRZ encoded data) 

per IRIG 106 Chapter 4. 

 

 

Figure 132: Encoding Menu, Bi-Phase Selection 

 

The user may toggle the Bi-Phase value by pressing the Enter key on the front panel keypad until the desired value 

(On or Off) displays. 

4.1.5.20 DC Antenna 

The DC Antenna option is only available when using the 5-band downconverter AND P and C bands are enabled. 
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The user may toggle the DC Antenna value On or Off by pressing the Enter key on the front panel keypad until the 

desired value displays. 

• When the downconverting antenna is not available, this command displays only an assumed value. 

• The downconverting antenna setting only applies to C band frequencies. 

 

 

Figure 133: Advanced Menu, DC Antenna Selection 

 

The downconverting antenna has an LO that is used to downconvert C band signals (4400 MHz – 5150 MHz) to a 

lower frequency range known as P band (400 MHz – 1150 MHz) using an LO frequency of 5550 MHz. This results 

in two issues that are addressed by the downconverting antenna control. 

1. Spectral Inversion 

In a downconverting antenna, the LO is higher than the RF (high side injection) and the lower side 

band result is selected—the spectrum is inverted. All C to P band downconverting antennas are 

assumed to produce a spectrally inverted signal. The receiver automatically reinverts the signal before 

it is demodulated. (This is done in the downconversion to 70 MHz IF.) If an actual P band signal is 

received, it is NOT spectrally inverted and the automatic reinversion done by the receiver improperly 

causes the signal to appear inverted to the demodulator. 

The demodulator has a mechanism to invert the spectrum in the digital domain. The downconverting 

antenna setting determines how the spectral inversion is handled for P band signals. 

2. C Band Frequency Specification Ambiguity 

It is common to tune to the C to P band downconverted signal by specifying the C band frequency. In a 

receiver that also has actual C band receiver capability, an ambiguity develops when a C band 

frequency is specified since it can be applied to either a C or P band signal. The downconverting 

antenna setting determines how a specified C band frequency is interpreted in a system where both C 

and P bands are enabled. 

If a C band frequency is specified and the downconverting antenna is enabled, it is assumed the signal 

is a C to P downconverted signal. The receiver is tuned to the P band equivalent and the automatic 

inversion is used. If the downconverting antenna is disabled, the receiver is tuned to the specified C 

band frequency and spectral inversion is not an issue. 

If a P band frequency is specified, it is assumed there is no downconverting antenna. If there is a 

downconverting antenna, it is ignored. The receiver is tuned to the actual P band frequency and the 

automatic spectral inversion is disabled. 
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4.1.5.21 Convolutional Decode 

The Convolutional Decoder (also commonly referred to as the Viterbi Decoder) is available in PCM/FM and legacy 

PSK modes. Its purpose is to decode data that has been encoded per “Consultative Committee for Space Data 

Systems, Recommendation for Space Data System Standards, TM Synchronization and Channel Coding, CCSDS 

131.0-B-1, Blue Book,” September 2003, Section 3. 

Convolutional encoding adds redundant information to the transmitted data stream. The Convolutional Decoder uses 

this information to detect and correct bit errors that may occur, particularly due to predominantly Gaussian noise. 

The encoded data rate is twice the specified data rate, and the occupied bandwidth is also doubled. 

For legacy PSK modes that use quadrature modulation (e.g., OQPSK), there are actually two independent decoders, 

one for in-phase (“I”) data and one for quadrature (“Q”) data. This approach assumes a similar arrangement for the 

encoders in the transmitter, which is true of all Quasonix transmitters. 

The user may toggle the Convolutional Decoding value On or Off by pressing the Enter key on the front panel 

keypad until the desired value displays. 

 

 

Figure 134: Advanced Menu, Convolutional Decode Selection 

 

4.1.5.22 SNR Estimator 

The SNR Estimator menu is available for all waveform modes. SNR estimation is used primarily to achieve proper 

channel weighting by the optimal ratio pre-detection diversity combiner. There are two algorithms available to 

estimate SNR: DSP and AGC. Under normal conditions, with proper AGC zeroing, these two algorithms give 

substantially similar results. 

The user may toggle the SNR Estimator value to AGC or DSP by pressing the Enter key on the front panel keypad 

until the desired value displays. 

The DSP-based SNR estimator numerically measures received power relative to noise power at the demodulator 

input, assuming the signal power is attributable to constant-envelope modulation and the noise power is attributable 

to additive white Gaussian noise. This measurement is very accurate when the SNR is below 30 dB, but it will rarely 

report a value above this (no matter how strong the signal). This selection is recommended for ARTM modulation 

types (Tier 0, I, and II) or when an accurate AGC zeroing process is not feasible. 

The AGC-based SNR estimator measures received power relative to the AGC zero point (i.e., noise floor). This 

estimation is insensitive to modulation and does not distinguish between intended signal and interfering signal. This 

selection is recommended for unknown signals or for signals with modulation that is not constant-envelope (for 

example, unshaped PSK). This method is also recommended when the received signals may be more than 30 dB 

above the noise floor. However, an accurate AGC zeroing process is required for accurate results. 
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Figure 135: Advanced Menu, SNR Estimator Selection, AGC and DSP 

 

4.1.5.23 Factory Default 

The Factory Default option allows the user to reset each channel of the Rack-Mount Demodulator/Receivers to the 

factory default settings. Factory Default reset does not affect Ethernet settings. 

 

 

Figure 136: Advanced Menu, Factory Default Selection 

 

4.2 Remote RDMS™ Client (RRC) Control 

RRC provides the user with full configuration, control, and monitoring capabilities for one or multiple rack-mount 

receivers. For configuration management purposes, only one client can configure a receiver at a given time. 

However, multiple clients can monitor an individual receiver’s status at once. 

The client’s monitoring capabilities include: 

• Receiver settings 

• Signal strength 

• Signal quality 

• Signal lock detect 
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• Combiner link status (optional Diversity Combiner feature required) 

• Constellation / eye pattern display 

• Client status 

Figure 137 shows the client with a control window and two monitoring windows open. 

The Remote RDMS™ Client consists of a tool bar at the top of the window, Selected RDMS Unit and Connect 

screen button at the top right, and the Basic RDMS Settings window which displays a variety of parameters for each 

available channel. 

 

 

Figure 137: Remote RDMS™ Client in Desktop Window 

 

Whenever there is activity in progress that cause network communications to be temporarily busy, a “Please Wait” 

message displays at the top of the Settings window. An example is shown in Figure 138. 

 

 

Figure 138: Please Wait Message 

 

4.2.1 Considerations for Running Multiple GUI Clients on a Single Computer 

When running multiple GUI clients on the same computer, the following cautions should be taken. 
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• It is possible for an actively selected rack in one GUI instance to be selected more than once for other 

active GUI instances on the same computer. If this is done, the active GUI instance will be the only GUI to 

have graphic waveforms and accurate values. 

It is recommended that the same rack NOT be selected more than once when more than one GUI is running 

on the same computer. 

• Caution should be taken when turning off an RDMS rack from the File menu when more than one instance 

of the RDMS GUI is running from a single computer. The RDMS GUI that shuts down the RDMS rack 

unit knows that this RDMS rack is shut down and no longer available, however, the remaining GUI 

instances will take up to three (3) minutes to see that the RDMS unit is missing. 

Selecting the missing RDMS rack from the other instances of the GUI may cause that GUI to wait for an 

extended period of time trying to connect. This is by design to prevent unwanted dropouts of RDMS racks 

on the GUI client under poor Ethernet conditions (WiFi or Wired). 

4.2.2 Selecting an RDMS™ Unit 

Upon opening, the Remote RDMS™ Client queries the client’s network to compile a list of rack-mount RDMS™ 

receivers present. The following message displays in the main window upon client initialization: 

 

 

Figure 139: Searching for RDMS Units Message 

 

After the list has been compiled, the user can select a unit to control by clicking on the down arrow in the Selected 

RDMS Unit menu in the upper right-hand corner of the main application window. Each unit within the network is 

displayed by its IP address, and alias name, if previously assigned, as shown in Figure 140. 

 

 

Figure 140: Selected RDMS Unit 
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After making a selection from the Selected RDMS Unit dropdown list, click on the Connect screen button to make a 

communications connection to the chosen RDMS™. 

 

 

Figure 141: Selected RDMS Unit and Connect Screen Button 

 

The Remote RDMS™ Client displays a message notifying the requestor that a connection attempt is being made, as 

shown in Figure 142. 

 

 

Figure 142: Connecting to RDMS™ Unit 

 

Additionally, the receiver’s menu LCDs will briefly show a connection image, as shown in Figure 143, to alert the 

operator that it is now being controlled remotely. 

 

 

Figure 143: RDMS™ Connected Image 
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4.2.3 Remote Control Menu 

The Remote Control menu provides two options: Basic Settings and Advanced Terminal, as shown in Figure 144. 

The Basic RDMS Settings window can be accessed at any time by navigating to the Main Menu and selecting: 

Remote Control > Basic Settings. 

 

 

Figure 144: Remote Control Menu 

 

4.2.3.1 Basic Settings 

The Basic RDMS Settings screen is shown in Figure 145. The Remote RDMS™ Client automatically connects to 

the rack that was selected from the Selected RDMS Unit dropdown list (Figure 140). 

 

 

Figure 145: Basic RDMS Settings Window 
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Two screen tabs are available on the Basic RDMS Settings screen: Basic Settings tab and Advanced Settings tab. 

4.2.3.1.1 Basic Settings Tab 

The Basic Settings tab provides the user with: 

• Channel selection 

• Basic receiver settings, such as frequency, mode, bit rate 

• Filter Settings 

• Screen buttons for initiating or cancelling actions 

• Signal indicators, including lock detect, signal strength, signal quality, combiner link status 

4.2.3.1.1.1 Channel Selection 

The user may access either channel display by clicking on any field. The Remote Client automatically switches to 

the correct channel. 

If the user is operating a single-channel receiver, only Channel 1 displays, as shown in Figure 146. 

 

 

Figure 146: Basic RDMS Settings, Only One Channel Available 
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4.2.3.1.1.2 On-screen Buttons 

The Basic Settings tab contains three on-screen buttons used to initiate or cancel various actions. These buttons 

(shown in Figure 147) are: 

• Apply Settings 

• Refresh Settings 

• Exit 

 

  

Figure 147: On-Screen Buttons 

 

The Apply Settings screen button changes color from white to flashing green to alert the user that one or more 

changes have been detected. To save the changes, the user must click on the Apply Settings screen button. 

Fields with checkboxes are exceptions to this procedure. When the user clicks on a checkbox to activate the field, 

the parameter is automatically updated. 

The Refresh Settings screen button is used to clear changes without applying/saving them. The field values revert 

back to the last applied values. For example, if the mode was PCMFM when the user opened the client and the user 

changed the mode to SOQPSK, but decided to continue using PCMFM, the user would click on Refresh Settings 

and the mode would revert back to PCMFM. 

The Exit screen button is used to close the Basic RDMS Settings Window without making any changes. The Client 

Application (containing the Menu bar) remains open. 

4.2.3.1.1.3 Basic Settings Window 

Directly below the client application status indicator is the Basic Settings window, shown in Figure 148. 
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Figure 148: Basic Settings Window 

 

The Basic Settings window includes all of the primary settings related to the receiver, including Frequency, Mode, 

Bit Rate, Data and Clock Polarity, and Derandomizer On, and an AGC Zero button. The Modulation Scaling option 

is only available with PCM/FM mode. 

Modulation Scaling contains four settings: Tracking, Locked, Off, and Acquire. Modulation Scaling is a method 

used to retain the maximum trellis-coding gain of a non-ideal FM signal. 

The Mode and Modulation Scaling settings can be adjusted by clicking on a dropdown menu and making a 

selection, while others require the user to enter specific values, such as bit rate and frequency settings, or to select a 

checkbox. The Mode selections are shown in Figure 149. The Modulation Scaling settings are shown in Figure 150. 

 

 

Figure 149: Basic Settings Window, Mode Menu 
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Figure 150: Basic Settings Window, Modulation Scaling Menu 

 

When Modulation Scaling is set to Tracking, the graphs display in red, as shown in Figure 151. 

 

 

Figure 151: Modulation Scaling Set to Tracking, Signal Graph Displays Red 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

85  Quasonix, Inc. 

 

When the RDMS™ is powered on, the default setting is Tracking, unless the unit was powered off from a preset 

condition. If the unit was powered off from an unmodified preset setting, then the default condition of Modulation 

Scaling is as defined in the preset. When Tracking is set, the modulation scale index is actively being tracked. 

Note: The active setting is not saved when the rack is powered off, unless the Modulation Persistence option was set 

to On. 

Frequency, mode, and bit rate changes, or any changes to a preset, cause the Modulation Scaling setting to revert 

back to Tracking. This is because the optimal signal monitoring is no longer valid. 

If there are two channels, and the Combiner is set to On, the Modulation Scaling is NOT linked. Modulation Scaling 

for channel one and channel two functions independently. 

Note: Whenever the Diversity Combiner is On, any changes made to the Frequency option (even with Frequency 

Diversity On enabled) causes Modulation Scaling for both channels to be set to Tracking. 

When the RDMS™ has a good lock on the target transmitter, Modulation Scaling should be set to Locked. 

When Modulation Scaling is set to Locked or Off, the graphs display in green, as shown in Figure 152. This 

indicates the optimal Modulation Index is set. For more information about the Modulation Index, refer to section 

4.2.3.1.2.2, Scale Settings Window. 

 

 

Figure 152: Modulation Scaling Set to Locked, Signal Graph Displays Green 
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Mod Scaling should be turned off when a new generation, digitally synthesized transmitter is the source. Digitally 

synthesized transmitters do not have a variable deviation sensitivity adjustment, and as such are not subject to 

inaccurate modulation index settings 

When Modulation Scaling is set to Acquire, the graphs display in yellow, as shown in Figure 153. 

 

 

Figure 153: Modulation Scaling Set to Acquire, Signal Graph Displays Yellow 

 

Acquire mode has two states: Armed and Triggered. When Modulation Scaling is set to Acquire, the state is set to 

Armed. In Armed state, modulation scaling operates continuously. 

If the receiver is locked and the delta h (the change in modulation index) has settled below the delta h threshold for 

the specified settling time, the state changes to Triggered and the eye pattern turns green. In Triggered mode, the 

estimated h (modulation index) is monitored but the scale is not updated. 

If delta h goes above the delta h threshold and settles again, the receiver is still locked, and the Eb/N0 at the settling 

point is higher than the last settling point, the current scaling is updated with the new estimate. 

There is no transition from Triggered back to Armed except for setting the mode to Acquire again. 
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4.2.3.1.1.4 Filter Settings Window 

Directly below the Channel number is the Filter Settings window, shown in Figure 154. 

 

 

Figure 154: Filter Settings Window, PCM/FM Mode 

 

Based on the receiver’s high level of integration, the proper IF filter is automatically selected based on the current 

mode and bit rate settings of the demodulator. Although manual filter selection is available through the Advanced 

Terminal window in the RDMS™ client, or via the IF Filter Menu on the front panel LCD, as shown in Figure 110, 

manual selection is not recommended. In the case of a receiver with diversity combining enabled, the two channels 

must have the same IF filter selected for proper operation. 

The basic premise of trellis demodulation relies on the precise phase modulation of the transmitted signal. Some 

older analog transmitters have an inordinate amount of phase noise, reducing the effectiveness of the trellis 

demodulator. In Tier 0 (PCM/FM), enabling the Phase Noise Compensation option (box checked) relaxes the 

requirements of the trellis demodulator, allowing better receive performance for transmitters with a high degree of 

phase noise. 

When the modulation is set to PCM/FM, the Filter Settings window includes settings for IF and Phase Noise 

Compensation. In any other mode, only the IF Filter option is available, as shown in Figure 155. 

 

 

Figure 155: Filter Settings Window, Non-PCM/FM Mode 

 

4.2.3.1.1.5 Signal Graph and Signal Indicators 

The Signal Graph, shown in Figure 156, provides a separate window for monitoring the receiver’s constellation or 

eye pattern. The graphical display, included for each channel, mimics the graphical display on the front panel of the 

rack-mount receiver. Depending on the modulation chosen, the monitor will either display an eye pattern for 

PCM/FM, or a signal constellation for the other modes. The monitor also features a Persistence selection (adjustable 
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from 0 to 100), which allows the user to increase or decrease the persistence applied to the graphics. The greater the 

persistence, the more stable the signal appears. 

To the right of the Signal Graph is the Signal Indicators window, also shown in Figure 156. 

The Signal Indicators window includes the following indicators for each receiver channel: 

• Signal Lock detection 

• Signal Strength 

• Signal Quality 

 

 

Figure 156: Signal Graph and Signal Indicators Windows 

 

A signal lock indicator provides a visual representation of the demodulator’s current lock-detect state. If the 

demodulator has locked onto a downconverted signal, a locked (closed) green padlock displays. Conversely, if the 

receiver has not locked onto a signal or has recently lost lock, the indicator turns red and displays as an unlocked 

padlock icon, as shown in Figure 157. 

 

 

Figure 157: Signal Indicators, Signal Not Locked 
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Signal strength is displayed on a dynamic bar graph and spans from -120 dBm to +10 dBm. In addition to the visual 

representation of signal strength, the current measurement, in dBm, is numerically displayed directly above the bar 

graph. When a signal of -100 dBm or higher is detected, the bar turns green to signify “good” signal strength. The 

Strength bar is red if the signal level is below -100 dBm. 

Signal quality graph displays to the right of the Strength graph. The signal quality range is 0 to 100, with 100 being 

the best possible quality. When the demodulator locks onto a signal, the signal quality bar turns green. Otherwise, 

the bar is displayed in red, regardless of the measured quality level. 

Note: The integrated Quasonix demodulator can detect and establish signal lock at very low signal levels. Therefore, 

it is not uncommon to see a red signal strength bar indicator accompanied with a green signal lock indicator. 

4.2.3.1.1.6 Diversity Combiner 

If the optional diversity combiner is installed and enabled between two channels, then a channel link icon is 

displayed inside the Diversity Combiner window to show that the two channels are being combined. This link icon 

with a signal lock (green) is shown in Figure 158. The combiner link icon without a signal lock (red) is shown in 

Figure 159.  

  

Figure 158: Diversity Combiner Link with Lock Figure 159: Diversity Combiner Link without Lock 

 

If diversity combiner is On (Combiner On is checked), any changes made to one channel will be copied to the other 

channel so that both channels are synchronized. If diversity combiner is Off (Combiner On is not checked), each 

channel is separate and setting one channel does not copy settings to the other channel. 

When turning on Diversity Combiner, the message in Figure 160 displays if any of the settings for channel 1 do not 

match channel 2. 

 

 

Figure 160: Diversity Combiner Error 
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If the Frequency Diversity On box is checked, the settings are automatically copied to both channels. 

Note: Whenever the Diversity Combiner is On, any changes made to the Basic Settings: Frequency option (even 

with Frequency Diversity On enabled) causes Modulation Scaling for both channels to be set to Tracking. 

4.2.3.1.1.7 Copy Channel Settings 

There may be instances where the operator does not want to use the diversity combiner but still wants to have any 

changes made to given channel copied to the other channel. Copy Channel Settings allows the user to select the 

channels to copy. 

Click on the Copy Enabled checkbox to allow channel copying, then select additional copy settings. 

If the CH1 => CH2 option is selected, then any settings made for channel 1 will be copied to channel 2 but channel 

2 settings will not copy to channel 1. 

The reverse is true if the operator selects the CH1 <= CH2 option. 

After selecting the desired copy option, click on the Copy All screen button to complete the copy action. 

Note: If the diversity combiner is On, the copy channel settings are ignored. 

 

 

Figure 161: Copy Channel Settings 

 

4.2.3.1.2 Advanced Settings Tab 

The Advanced Settings tab displays in two different formats: one format when the modulation is set to PCM/FM and 

a second format for all other modulation settings. 

When the modulation is set to PCM/FM. the Advanced Settings tab provides the user with: 

• Modulation Scale Settings 

• AGC and AM settings for antenna tracking 

• Tape Output Settings 

• Muting Settings 

• Synchronize Bit Rate Settings 

• Video Settings 

• Encoding selections 

• Four Enable/Disable checkbox options: Bi-Phase, Convolutional Decoder, Spectrum Inversion, and DC 

Antenna 
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The Advanced Settings tab for PCM/FM mode is shown in Figure 162. 

 

 

Figure 162: Advanced Settings Tab (PCM/FM Version) 

 

When the modulation is set to any non-PCM/FM mode, the Advanced Settings tab provides the user with: 

• AGC and AM settings for antenna tracking 

• Tape Output Settings 

• Muting Settings 

• Synchronize Bit Rate Settings 

• SNR Estimator selections 

• Enable/Disable checkbox options for Bi-Phase, Convolutional Decoder, Spectrum Inversion, and DC 

Antenna 

The Advanced Settings tab for all modes except PCM/FM is shown in Figure 163. 
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Figure 163: Advanced Settings Tab (Non-PCM/FM Version) 

 

4.2.3.1.2.1 On-screen Buttons 

The Advanced Settings tab contains four on-screen buttons used to initiate or cancel various actions. These buttons 

(shown in Figure 164) are: 

• Apply Settings 

• Refresh Settings 

• Exit 

• Factory Reset (located at the bottom right corner of each Channel window) 
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Figure 164: On-Screen Buttons 

 

The on-screen buttons work the same way as the buttons on the Basic Settings tab. Refer to section 4.2.3.1.1.2 for 

additional details. 

In addition, both Channel windows include a Factory Reset screen button, located in the bottom right corner of each 

Channel window. The Factory Reset button is used to reset all settings, EXCEPT Ethernet settings, for a selected 

Channel to their factory default values. If the Diversity Combiner is active, both Channels are reset. 

4.2.3.1.2.2 Modulation Scale Settings Window 

The Modulation Scale Settings window is shown in Figure 165. When the modulation is set to PCM/FM, the Scale 

Settings window includes settings for modulation scaling and video scaling indexes. In any other mode, the Scale 

Settings are not available. 

 

 

Figure 165: Modulation Scale Settings Window 

 

The Mod Scaling option allows the operator to manually set the modulation scale index. This enables the receiver to 

operate at the optimum range of modulation desired by the user. 

Modulation Persistence allows the current state of the Modulation Scaling setting to be retained following a power-

off cycle. The default value is Off (not checked). 

When modulation scale index is set, the Modulation Scaling option on the Basic Settings screen is simultaneously 

changed to Locked. The Locked notation includes the new index number that the operator has chosen (shown in 

Figure 165). 

If the Locked index number is to be retained following a power-off cycle of the rack, then turn on Modulation 

Persistence by checking the Modulation Persistence box on the Basic Settings screen. Save the current setup profile 

using the Save Presets option. Refer to section 4.2.8.1, Save/Load Presets. 

The purpose of the Mod Scale Hold Threshold option is to set a signal-to-noise ratio (SNR) level (technically 

Eb/N0* level) below which the modulation index estimate will hold rather than track, so it does not get perturbed by 
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noise. When Mod Scaling is in Tracking mode, the modulation index estimate becomes poorer as the SNR decreases 

(that is, as the received signal gets weak). This in turn negatively impacts demodulation performance, making bit 

errors more likely than they would be if the modulation index were known a priori. 

• Eb/N0 is the ratio of signal energy per bit (Eb) to noise energy spectral density (N0), which is sometimes 

referred to as “SNR per bit.” 

4.2.3.1.2.3 AGC Settings Window 

The AGC (Automatic Gain Control) Settings window includes the following parameters: 

• AGC Gain (00) 

• AGC Time Constant (in ms) 

• AGC Zero Hold 

• AGC Freeze On 

• AGC Polarity Inverted 

 

 

Figure 166: AGC Settings Window 

 

AGC Zero is used to set a baseline for background radio noise levels. A typical application of the AGC Zero 

function is explained in the following example. 

1. Connect the receiver to its normal RF signal source, such as antenna, LNA, cabling, and splitters. 

2. Orient the receiving antenna in a direction that is expected to yield the lowest signal level that the receiver 

is likely to encounter. 

3. Activate AGC Zero under this condition by clicking on the AGC Zero screen button, shown in Figure 166. 

The AGC output voltage is set to zero volts DC at a time when the receiver input is at its minimum value. 

This process ensures that the AGC output voltage will not cross through zero volts DC under normal 

operation. 

4.2.3.1.2.4 AM Settings Window 

The AM (Amplitude Modulation) Settings window includes the following parameters: 

• AM Bandwidth (KHz) 

• AM Time Delay (us) 

• AM Scale (0.05-2.5) 

• AM Polarity Inverted (+/-) 

• AGC Compensate 
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Figure 167: AM Settings Window 

 

4.2.3.1.2.5 Tape Output Settings Window 

The Tape Output Settings window, located below the AM Settings window, is shown in Figure 168. It consists of 

two options: Tape Output Enabled and Tape Frequency. 

The “Q” channel output of the RDMS™ normally delivers the Q channel of the demodulated signal (likewise with 

the I channel). Setting the Tape Output Enabled option to On (box checked) reassigns that output to deliver an IRIG 

tape signal. This is essentially the IF signal, frequency shifted to the carrier frequency specified by the Tape 

Frequency setting. Another way of saying this is that pre-detection complex baseband is selected as the source of the 

data to send on the I and Q analog outputs. Setting the Tape Output Enabled option to Off (box not checked) restores 

the I and Q channel outputs (frequency/phase information) to their default condition which varies by mode. 

Please refer to section 3.3.1 for a complete description of back panel connectors, including pinouts. 

 

 

Figure 168: Tape Output Settings Window 

 

The Tape Frequency option allows the operator to manually set the tape output carrier frequency (in MHz) by typing 

the desired value. The valid range is between 0.000 MHz and 20.000 MHz. 

4.2.3.1.2.6 Muting Settings Window 

The Muting Settings window, located below the Tape Output Settings window, is shown in Figure 169. It consists of 

two options: Muting Enabled and Muting Timeout. 

 

 

Figure 169: Muting Settings Window 

 

The Muting Enabled checkbox is used to set the muting value to On or Off. When Muting Enabled is checked (set to 

On), the receiver stops sending clock and data information when the timeout value is reached. This option is 

beneficial to someone using a recorder with limited space. For example, if data is not locked to a valid signal or is 

outside the valid range, the information is muted (stopped) so the recorder is not filled with bad data. 
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The Muting Timeout option is used to set a timeout value (in milliseconds). This setting is used to determine when 

to mute (stop sending data) when the Muting Enabled option is set to On (checked). The valid range is 0 to 46016 

milliseconds. 

4.2.3.1.2.7 Synchronize Bit Rate Settings Window 

The Synchronize Bit Rate Settings window, located below the Muting Settings window, is shown in Figure 170. It 

consists of a Set Measured Bit Rate screen button and a Measured Bit Rate field. 

Synchronize Bit Rate Settings sets the receiver’s commanded bit rate to the value it is currently measuring on the 

input signal. The purpose of this process is to eliminate unintended bit rate offset error so that the receiver can make 

full use of its bit synchronizer tracking range, or optionally reduce its tracking range. For the receiver to have an 

accurate measurement, however, the input signal must be close enough to the previously commanded bit rate to be 

within the current bit synchronizer lock range and actually be locked. 

Click on the Set Measured Bit Rate screen button to display an optimum number in the Measured Bit Rate field. A 

signal lock must be present for the measured bit rate to be valid. You may also type a number into the Measured Bit 

Rate field. Allowable value ranges vary depending on the waveform mode in use. (You must click on the Apply 

Settings screen button for the Measured Bit Rate setting to be accepted.) 

 

 

Figure 170: Synchronize Bit Rate Settings Window 

 

4.2.3.1.2.8 Video Settings Window 

The Video Settings window, shown in Figure 171, provides controls over the analog (Video A/Video B) outputs 

when the receiver is being used as an analog receiver. 

The Video Scale option sets the peak-to-peak amplitude on the video outputs. By default the video output is 1 V 

peak-to-peak using a standard deviated NTSC video signal. This setting allows the user to compensate for a system 

where this is not the case. 

The Video Filter option, available in PCM/FM mode, sets the system bandwidth for the analog signal. Nominally, 

NTSC color video is approximately 6 MHz in bandwidth and black and white is 4 MHz. This setting allows the user 

to control the cutoff of the video band pass. 

Note: Operating the receiver in analog mode is mutually exclusive with operating it as a digital receiver. The bit rate 

for the digital receiver and the video filter cannot be set independently of one another. 

In Tier 0 (PCM/FM), the “Q” channel output of the RDMS delivers the demodulated FM output. Enabling the Video 

Signal Invert option (box checked) inverts the FM output. 
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Figure 171: Video Settings Window 

 

4.2.3.1.2.8.1 NTSC Video Demodulation 

While Quasonix RDMS™ receivers are primarily intended for digital data demodulation, analog FM waveforms can 

also be demodulated. 

When using the PCM/FM mode, base band analog from an FM digital appears on the I/Video A BNC connector. 

The requirements for receiving analog FM are different from the requirements for receiving telemetry data and the 

RDMS™ receiver has a number of controls that can be adjusted to optimize analog demodulation. 

The primary controls are: 

• Mode 

• Bit-rate 

• IF filter bandwidth 

• Video Bandwidth 

• Video Scale 

• Video Invert 

For demodulation of standard NTSC-Video, use the following settings. 

On the Basic Settings window: 

• Mode - Set to PCM/FM to enable the FM demodulator 

• Bit-rate - Set to 3 Mbps 

• IF filter - Must be a minimum of 6 MHz (the actual filter used will depend on the number of IF filters 

installed) 

On the Advanced Settings window: 

• Video Bandwidth - Set to 6 MHz 

• Video Scale - Set to 0.25 to provide a 1V p-p video signal 

• Video Invert - Set to Off by default 

If there are any spectral inversions in the system (such as a C to P band down converting antenna), Video 

Invert should be set to On. 

4.2.3.1.2.9 Additional Advanced Settings 

Other settings are available on the Advanced Settings tab. When the receiver is in PCM/FM mode, four options may 

be enabled or disabled by clicking on the checkbox next to the option. The options are Bi_Phase. Convolutional 

Decoder, Spectrum Inversion, and DC Antenna. They are described following Figure 172. Only Spectrum Inversion 

and DC Antenna are available for all other modes. 
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4.2.3.1.2.9.1 Encoding Menu 

The Encoding dropdown menu, available in PCM/FM mode, is used to set the non-return to zero (NRZ) value used 

by the receiver. NRZ is a way of encoding binary data on a physical signal. The options are: 

• NRZ-L – Non-return to zero Level 

• NRZ-M – Non-return to zero Mark (1) 

• NRZ-S – Non-return to zero Space 

 

 

Figure 172: Additional Advanced Settings, Encoding Menu Highlighted, PCM/FM Mode Only 

 

Bi-Phase encoding (box checked) enables the demodulator to process Bi-Phase encoded data (as opposed to NRZ 

encoded data) per IRIG 106 Chapter 4. 

The Spectrum Inversion option inverts the frequencies (box checked) processed by the demodulator relative to how 

they appear at the IF Output port. That is, low frequencies within the IF Filter bandwidth become high frequencies 

within the demodulator and vice versa. This can be used to compensate for a frequency inversion elsewhere in the 

system. 

4.2.3.1.2.9.2 Convolutional Decoder 

Convolutional Decoder (box checked) enables the Viterbi decoder. 

The Convolutional Decoder (also commonly referred to as the Viterbi Decoder) is available in PCM/FM and legacy 

PSK modes. Its purpose is to decode data that has been encoded per “Consultative Committee for Space Data 

Systems, Recommendation for Space Data System Standards, TM Synchronization and Channel Coding, CCSDS 

131.0-B-1, Blue Book,” September 2003, Section 3. 

Convolutional encoding adds redundant information to the transmitted data stream. The Convolutional Decoder uses 

this information to detect and correct bit errors that may occur, particularly due to predominantly Gaussian noise. 

The encoded data rate is twice the specified data rate, and the occupied bandwidth is also doubled. 

For legacy PSK modes that use quadrature modulation (e.g., OQPSK), there are actually two independent decoders, 

one for in-phase (“I”) data and one for quadrature (“Q”) data. This approach assumes a similar arrangement for the 

encoders in the transmitter, which is true of all Quasonix transmitters. 

4.2.3.1.2.9.3 Downconvert Antenna 

The DC Antenna option (box checked) is only available when using the 5-band downconverter AND P and C band 

are enabled. 

• When the downconverting antenna is not available, this command displays only an assumed value. 

• The downconverting antenna setting only applies to C band frequencies. 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

99  Quasonix, Inc. 

 

 

Figure 173: Additional Advanced Settings, Check Boxes 

 

The downconverting antenna has an LO that is used to downconvert C band signals (4400 MHz – 5150 MHz) to a 

lower frequency range known as P band (400 MHz – 1150 MHz) using an LO frequency of 5550 MHz. This results 

in two issues that are addressed by the downconverting antenna control. 

1. Spectral Inversion 

In a downconverting antenna, the LO is higher than the RF (high side injection) and the lower side 

band result is selected—the spectrum is inverted. All C to P band downconverting antennas are 

assumed to produce a spectrally inverted signal. The receiver automatically reinverts the signal before 

it is demodulated. (This is done in the downconversion to 70 MHz IF.) If an actual P band signal is 

received, it is NOT spectrally inverted and the automatic reinversion done by the receiver improperly 

causes the signal to appear inverted to the demodulator. 

The demodulator has a mechanism to invert the spectrum in the digital domain. The downconverting 

antenna setting determines how the spectral inversion is handled for P band signals. 

2. C Band Frequency Specification Ambiguity 

It is common to tune to the C to P band downconverted signal by specifying the C band frequency. In a 

receiver that also has actual C band receiver capability, an ambiguity develops when a C band 

frequency is specified since it can be applied to either a C or P band signal. The downconverting 

antenna setting determines how a specified C band frequency is interpreted in a system where both C 

and P bands are enabled. 

If a C band frequency is specified and the downconverting antenna is enabled, it is assumed the signal 

is a C to P downconverted signal. The receiver is tuned to the P band equivalent and the automatic 

inversion is used. If the downconverting antenna is disabled, the receiver is tuned to the specified C 

band frequency and spectral inversion is not an issue. 

If a P band frequency is specified, it is assumed there is no downconverting antenna. The receiver is 

tuned to the actual P band frequency and the automatic spectral inversion is disabled. 

4.2.3.1.2.9.4 SNR Estimator Menu 

The SNR Estimator menu is available for all waveform modes. SNR estimation is used primarily to achieve proper 

channel weighting by the optimal ratio pre-detection diversity combiner. There are two algorithms available to 

estimate SNR: DSP and AGC. Under normal conditions, with proper AGC zeroing, these two algorithms give 

substantially similar results. 

 

 

Figure 174: Additional Advanced Settings, SNR Estimator 
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The DSP-based SNR estimator numerically measures received power relative to noise power at the demodulator 

input, assuming the signal power is attributable to constant-envelope modulation and the noise power is attributable 

to additive white Gaussian noise. This measurement is very accurate when the SNR is below 30 dB, but it will rarely 

report a value above this (no matter how strong the signal). This selection is recommended for ARTM modulation 

types (Tier 0, I, and II) or when an accurate AGC zeroing process is not feasible. 

The AGC-based SNR estimator measures received power relative to the AGC zero point (i.e., noise floor). This 

estimation is insensitive to modulation and does not distinguish between intended signal and interfering signal. This 

selection is recommended for unknown signals or for signals with modulation that is not constant-envelope (for 

example, unshaped PSK). This method is also recommended when the received signals may be more than 30 dB 

above the noise floor. However, an accurate AGC zeroing process is required for accurate results. 

4.2.4 Remote Monitoring Menu 

The Remote Monitoring menu contains one option, Multiple RDMS Performance Monitor, as shown in Figure 175. 

To access the Multiple RDMS Performance Monitor, navigate to the Main Menu, and then select Remote 

Monitoring > Multiple RDMS Performance Monitor. 

 

 

Figure 175: Multiple RDMS Performance Monitor 

 

4.2.4.1 Multiple RDMS Performance Monitor 

The Multiple RDMS Performance Monitor offers a quick snapshot of each rack-mount receiver, down to the channel 

level. The monitor is comprised of a table with columns for RDMS IP address, RDMS alias, channel, mode, bit rate, 

modulation scaling, modulation scale index, signal strength, signal quality, lock-detect status (as text and as a red or 

green color block), and channel active status. 

The Multiple RDMS Performance Monitor uses a numerical representation for signal strength and signal quality. 

The range of signal strength readings is from -120 dBm to +10 dBm. For signal quality, the range is a unit-less 1 to 

99, with 99 being the best possible quality. Also similarly, the status consists of a bar that is either green for a locked 

signal or red for loss of lock. 

At the bottom of the monitor window is a button that allows the user to show or hide inactive channels and a 

checkbox for the All Devices Signal Lock Indicator, which tells the operator that all of the rack channels have signal 

lock. 

Figure 176 shows a single RDMS™ with two active channels. The Signal Lock field is highlighted in red to indicate 

there is no signal lock. 
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Figure 176: Multiple RDMS Performance Monitor, Two Active Channels, Signal Not Locked 

 

Figure 177 shows a single RDMS™ with two active channels. The Signal Lock field for Channel 1 is highlighted in 

green and lock status is “True” to indicate a signal lock. Channel 2 is highlighted in red and lock status is “False” to 

indicate there is no signal lock. 

 

 

Figure 177: Multiple RDMS Performance Monitor, Two Channels, One Signal Locked 

 

Figure 178 shows a single RDMS™ with two active channels. The Signal Lock field for Channel 1 and Channel 2 is 

highlighted in green and lock status is “True” to indicate both channels have signal lock. 
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Figure 178: Multiple RDMS Performance Monitor, Two Active Channels, Both Signals Locked 

 

The user may hide inactive RDMS™ units, as shown in Figure 179. This is helpful when only a few channels from 

one or more RDMS™ racks are needed for telemetry and the screen needs to be free of unnecessary channels, or 

when multiple users are responsible for different RDMS™ units in the rack. A user may click on a line to hide any 

channel from view. Hiding channels on any given unit removes them from the spreadsheet display. Hidden channels 

are not used in calculating the All Devices Signal Lock Indicator. To show hidden channels, click on the Show 

Inactive Test Channels screen button. 

 

 

Figure 179: Multiple RDMS Performance Monitor, Inactive Channels Hidden 

 

If more than one Rack-Mount receiver is present in a network, the operator can use the Multiple RDMS 

Performance Monitor to view the status of each unit, as shown in Figure 180 and Figure 181. 

An installation with two receivers in a rack is illustrated by Figure 180. One receiver has signal locks on both 

channels and the other receiver has no signal lock on Channel 1 or Channel 2. 

An installation with four receivers in a rack is illustrated by Figure 181. Two receivers have signal locks on Channel 

1 and Channel 2, while the other two receivers have no signal lock on Channel 1 or Channel 2. 
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Figure 180: Multiple RDMS Performance Monitor, Two RDMS™ Receivers in Rack 

 

 

 

Figure 181: Multiple RDMS Performance Monitor, Four RDMS™ Receivers in Rack 

 

4.2.5 Tools Menu 

The Tools menu, shown in Figure 182, provides three options: Network Settings, Arrange Windows, and Firmware 

Upgrade. 

 

Figure 182: Tools Menu 
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4.2.5.1 Network Settings 

The RDMS Network Setting screen, shown in Figure 184, is accessed via the Tools menu (Tools > Network 

Settings), shown in Figure 183. 

 

 

Figure 183: Tools Menu, Network Settings Option 

 

All Ethernet settings for the rack-mount receiver that is currently selected are found on the Network Settings 

window. The window is divided into four sub-windows: 

• Ethernet Settings 

• Status 

• Alias Name 

• Additional Information 

 

 

Figure 184: Network Settings Screen 
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4.2.5.1.1 Ethernet Settings 

The Ethernet Settings window, shown in Figure 185, includes all of the standard Ethernet settings along with a 

checkbox used to automatically find an IP address. Fields include: 

• IP Address 

• Subnet Mask 

• Default Gateway 

 

 

Figure 185: Network Settings, Ethernet Settings Window 

 

4.2.5.1.2 Status 

The Network Settings window also includes a Status window, shown in Figure 186, which displays messages that 

occur as a result of the operator applying network settings. 

 

 

Figure 186: Network Settings, Status Window 

 

4.2.5.1.3 Alias Name 

The Network Settings-Alias Name window, shown in Figure 187, displays the current alias name, if used. This field 

may be edited by the user. This optional parameter is used to provide an alternative name to a rack in addition to the 

IP Address. The default alias name is RDMS. When using the Multiple RDMS Performance Monitor (refer to 

Section 4.2.4.1), the alias can be used to quickly identify a particular rack in the displayed list. Examples of a rack 

alias might be “RDMSLab1”, “TestLabLevel4”, or “XYZProjectRDMS”. 
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To add a new rack alias, type a name (up to 16 characters A-Z and/or 0-9), then click on the Apply Settings screen 

button. The new alias name is immediately displayed in the Network Settings-Additional Information, RDMS Unit 

Alias window and in the Selected RDMS Unit window on the upper left corner of the desktop window. 

 

 

Figure 187: Network Settings, Alias Name Window 

 

4.2.5.1.4 Additional Information 

The Network Settings-Additional Information window, shown in Figure 188, provides a listing of the UDP ports 

used for pass-through data and graphics. 

 

 

Figure 188: Network Settings, Additional Information Window 

 

Changes to all Network settings must be followed by clicking on the Apply Settings screen button for the changes to 

take effect. 

To exit the Network Settings window without making any changes, click on the Cancel screen button. 

4.2.5.2 Arrange Windows 

The Arrange Windows menu, shown in Figure 184, is accessed via the Tools menu (Tools > Arrange Windows), 

shown in Figure 183. Arrange Windows contains one option, Restore Default Locations. 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

107  Quasonix, Inc. 

 

 

Figure 189: Tools Menu, Arrange Windows Option 

 

4.2.5.2.1 Restore Default Locations 

Some users may have more than one instance of the client running and view the screens on two or more computer 

monitors. The Arrange Windows/Restore Default Locations option sets the number of extra monitors to zero. This 

resets the settings used when loading additional desktop client instances to only one monitor. This option also resets 

any dialog window size and locations to factory defaults. 

4.2.5.3 Firmware Upgrade 

The Firmware Upgrade option, shown in Figure 190, is accessed via the Tools menu (Tools > Firmware Upgrade). 

 

 

Figure 190: Tools Menu, Firmware Upgrade Option 

 

The Firmware Upgrade option is used to install the latest software on the Rack-Mount RDMS receiver. 

4.2.6 Mission Management Menu 

The Mission Management menu provides two options: Mission Control and Group Security Filter. 

 

 

Figure 191: Mission Management Tab, Mission Control Option 

 

4.2.6.1 Mission Control 

To access the Mission Control screen, navigate to the Main Menu and then select Mission Management > Mission 

Control, as shown in Figure 191. 
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The Mission Control screen contains the Active Clients and Messages windows along with the Enable Master screen 

button. The full window is shown in Figure 192. 

 

 

Figure 192: Mission Control Screen 

 

The Active Clients window, shown in Figure 193, contains the following information fields: 

• Client IP – Individual IP address for a PC connected to the RDMS™ 

• Client Name – Name associated with the Client IP 

• Client Master – The Mission Control operator – unit currently in control of the RDMS™; has the ability to 

control all racks 

• Rack IP – IP address for the RDMS™ rack 

• Rack Alias – Alternative descriptive name assigned to the rack  

• Assigned – Indicates whether or not the Client IP is connected to the Rack IP 

Client racks are displayed in the order in which they are opened with the last opened client displaying on the top 

line. Clients drop off of the list when they become inactive. Display order cannot be changed. 

 

 

Figure 193: Mission Control, Active Clients Window 

 

The Messages window, shown in Figure 194, provides the name of the Client PC and the Client IP address in the 

grey frame. There is a Dock/Undock screen button in the upper right corner that allows the Mission Control 

windows to be locked in the lower left corner of the PC screen or allowed to float freely on the screen. 

The Messages window allows a chat session between active clients. Type a message in the text box at the bottom of 

the window and click on the Send screen button. 
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Figure 194: Mission Control, Messages Window 

 

The example in Figure 195 shows a test message that was sent by a client. 

 

 

Figure 195: Messages Window, Message Displayed 

 

4.2.6.1.1 Control of Mission Control Client Window 

The following examples describe the steps that may be used to connect and control an RDMS™ rack. 

Using the Selected RDMS Unit dropdown list, Client 1 selects a rack name and clicks on the Connect screen button. 

 

 

Figure 196: Selected RDMS Unit and Connect Screen Button 

 

In this example, the selected rack is assigned to another client. A rack assignment notification message displays, as 

shown in Figure 197. 
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Figure 197: Rack Assigned to Another Client Message 

 

Client 1 clicks on Yes to ask for rack control and receives a Request Sent message, as shown in Figure 198. 

 

 

Figure 198: Request Sent Message 

 

After the request for control is sent, the Mission Management tab on Client 2’s RDMS menu bar begins to flash. 

Figure 199 shows Client 2’s desktop and Figure 200 shows only the Mission Management tab. 
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Figure 199: Tool Bar Flashes – Another Client Wants Control of Rack 

 

 

 

Figure 200: Close Up of (Flashing) Mission Management Tool Bar 

 

 

An example of another Client 2’s Mission Control Window is shown in Figure 201. 
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Figure 201: Example – Client 2’s Mission Control Window 

 

Client 2’s Active Clients window shows Client Name HCD-L2 is assigned to rack RDMS_DEV (Figure 202). 

 

 

Figure 202: Example – Client 2’s Active Clients Window 

 

Client 2’s Messages window shows the request message generated by Client 1 (ERIC-LAPTOP) (Figure 203). 

 

 

Figure 203: Example – Client 2’s Messages Window Prior to Denying Control 

 

In Scenario A, Client 2 (HCD-L2) denies the request by clicking on the Deny screen button. Client 2 has the option 

of sending a chat message using the text box at the bottom of the Messages window. This message could be an 

explanation for the denial or a message such as, “I’ll be finished in 20 minutes.” The “Denied” message, shown in 

Figure 204, is sent automatically to all active clients. Messages sent from each client display in a different color in 

the chat window. In addition, Client 2’s Mission Management bar is no longer flashing. 
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Figure 204: Example – All Clients’ Messages Window with Automatic Denial Message 

 

In Scenario B, Client 2 (HCD-L2) releases control of the RDMS™ rack by clicking on the Release screen button, 

shown in Figure 205. Again, Client 2 has the option of sending a chat message using the text box at the bottom of 

the Messages window. This message could be a simple “Releasing rack in 5 minutes” or a message such as, “How 

long do you need the rack?” 

 

 

Figure 205: Example – Client 2’s Messages Window Prior to Releasing Control 

 

After Client 2 (HCD-L2) clicks on the Release screen button; the Close Selected Rack Controls message displays 

(Figure 206). The message window gives Client 2 the chance to change his mind by clicking on No, or continuing 

by clicking on Yes. 

 

 

Figure 206: Example – Close Selected Rack Controls Message 
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Client 2 (HCD-L2) clicks on Yes. Immediately the message window closes, Client 2’s RDMS Client window closes, 

and the Mission Control Active Clients windows for Client 1 and 2 now show Client 2 as “Not Assigned” to a rack. 

 

 

Figure 207: Example – Mission Control Window for Both Clients 

 

A close-up view of the Active Clients window, Figure 208, shows Client 2 (HCD-L2) is no longer assigned to the 

RDMS_DEV rack, though his client desktop is still open. If Client 2 closes his RDMS client desktop application, his 

entry will drop off of the Active Clients list. 

 

 

Figure 208: Example – Mission Control Window for Both Clients 

 

4.2.6.1.2 Client Master 

The Client Master, simply put, is the person with the password – a mission operator, supervisor, team leader, 

security officer, etc. – some designated person. A Client Master has the ability to take control of any rack without 

the permission of the client who owns the rack. 

This option should only be used in an emergency when an RDMS™ rack client is open and unattended – the 

Client Master needs the rack and can’t get a response from anyone to release control in spite of repeated requests. 

This is important because the action may result in an active, assigned client being immediately shutdown with no 

warning—as if someone pulled a plug. 

In the following example, ERIC-LAPTOP needs control of the rack and can’t get it for some reason. No one with 

access to HCD-L2 is responding to requests for control. 

Client ERIC-LAPTOP (who happens to be the Mission Operator with the password) clicks on the Enable Master 

screen button, shown in Figure 209. 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

115  Quasonix, Inc. 

 

 

Figure 209: Enable Master Example – Active Clients with Enable Master Screen Button 

 

In the dark blue Options Master box, shown in Figure 210, client ERIC-LAPTOP must enter the Pass Code and click 

on the Apply screen button to take over as the Client Master of HCD-L2. 

 

 

Figure 210: Mission Control with Options Master Pass Code Box 

 

Immediately, Client HCD-L2’s RDMS™ client window is closed without warning and HCD-L2 becomes the new 

client master as evidenced by the “True” in the Client Master field next to HCD-L2’s name, shown in Figure 211. It 

doesn’t matter whether the rack is assigned or not when it is taken. At this time, the owner of HCD-L2 no longer 

may access it. Only the ERIC-LAPTOP owner has access to HCD-L2 until he disables it as a client master. An 

Access Granted message displays for ERIC-LAPTOP, as shown in Figure 212. 

 

 

Figure 211: Mission Control Client HCD-L2 Master Enabled 
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Figure 212: Access Granted Message 

 

As a courtesy, ERIC-LAPTOP (ERIC-PC in the following example) left a chat message for HCD-L2, shown in 

Figure 213. 

 

 

Figure 213: Message to HCD-L2 from ERIC-PC (ERIC-LAPTOP) 

 

It is important to remember that since ERIC-LAPTOP took control of the HCD-L2’s rack, no one else can access 

that rack until ERIC-LAPTOP releases control of the HCD-L2 rack. 

To disable master control, the HCD-L2 client must click on the Disable Master screen button and complete the steps 

to return control of the rack to standard operating procedure. 

4.2.6.2 Group Security Filter 

RDMS™ racks may be configured two different ways, depending on the preferred structure. A Group Identifier (ID) 

is used to provide a unique name for each RDMS™. In the first configuration, racks may be named based on 

department, such as Lab, Development, Production, Demonstration, etc. In the second configuration, racks may be 

named for independent users, such as Office1, B4Btest, JoeX, etc. The Group ID may only be configured via the 

RDMS™ front panel. Refer to section 4.1.5.8.5 for configure procedures. 

The sections following describe the functionality of the Ethernet Group ID filter screen. 

To access the Group Security Filter, navigate to the Main Menu, then select Mission Management > Group Security 

Filter, as shown in Figure 214. 
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Figure 214: Mission Management Menu, Group Security Filter Option 

 

4.2.6.2.1 Ethernet Group ID Filter 

The Ethernet Group ID Filter screen, shown in Figure 215, contains two fields: Group ID and Notes, plus a variety 

of on-screen buttons and an option for additional filter settings. 

 

 

Figure 215: Mission Management Tab, Group Security Filter – Ethernet Group ID Filter Screen 

 

4.2.6.2.2 Notes 

Use of the Notes field is optional and used for any descriptive entry to help identify where or what this rack is used 

for.  The examples in Figure 218 and Figure 219 are used to describe the locations of the rack units, however, any 

description may be used. 

4.2.6.2.2.1 Additional Filter Settings 

The Allow Public Racks checkbox is used to turn On or Off visibility of racks that do not have a Group ID assigned 

to them. Any rack with a blank Group ID is considered public. Older RDMS™ rack units that do not have the group 

security identification are by default public RDMS™ racks. 

4.2.6.2.2.2 Screen Buttons 

Save Table File Screen Button 

This button saves the complete Group ID list table into an XML file. Click on the Save Table File button. A 

Windows Explorer Save As screen displays, as shown in Figure 216, allowing the user to determine a location and 

name for the saved file. Scroll to the desired drive and folder. In the File name field, type the name for the Group ID 

list. Click on the Save screen button to save the file then exit the Save As screen. 
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Figure 216: Save Group ID Table File, Windows Explorer Selection Screen 

 

Load Table File Screen Button 

This button loads a saved Group ID list. Click on the Load Table File button. A Windows Explorer Open screen 

displays, as shown in Figure 217, allowing the user to select a saved XML file. Scroll to the desired drive and folder, 

then select the desired Group ID file to load. Click on the Open screen button to load the file and exit the Open 

screen. 
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Figure 217: Load Group ID Table File, Windows Explorer Selection Screen 

 

Clear Table Screen Button 

This button erases all entries in the table. Use this option only when necessary to clear ALL of the entries for a new 

setup. 

Help Screen Button 

This button displays an online Help file, Ethernet Group Identification. 

Delete Row Screen Button 

This button erases only a selected entry row in the table. Use this option to clear any row that is no longer needed. 

Save Changes Screen Button 

This option saves the table entry. Use this option to save all changes to the table. After saving changes, the Windows 

client identifies any new rack additions or deletions in the Selected RDMS Unit dropdown menu on the top right 

hand side of the main client screen, as shown in Figure 1.  If the rack addition or deletion changes do not display, 

you may need to apply the changes again or check to make sure your Group ID settings match the actual rack group 

ID settings. 
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Figure 218: Selected RDMS Unit 

 

Exit Screen Button 

This option will exit the Ethernet Group ID Filter screen. If any changes have been made to the table, you will be 

asked to save the changes before exiting. 

4.2.6.2.3 RDMS Racks Configured By Department Groups 

This section describes a Group ID configuration in which all RDMS™ racks are identified by department group ID 

and Notes are used to further specify a particular RDMS™. 

 

 

Figure 219: Group Security Filter, Ethernet Group ID Filter Screen – Filtered by Department 

 

In Figure 219, the racks from two departments, Development and Lab, are visible on the Windows RDMS™ client. 

RDMS™ racks assigned with other group identification names are not visible. This allows racks to be easily 

separated into groups. If you prefer racks filtered individually, assign a unique rack Group ID to each rack. (Refer to 

section 4.2.6.2.4.) 

4.2.6.2.4 RDMS™ Racks Configured With Independent Group ID Names 

This section describes a Group ID configuration in which all RDMS™ racks are identified individually. Notes are 

used to further distinguish a particular RDMS™ from others in the table. 
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Figure 220: Group Security Filter, Ethernet Group ID Filter Screen – Filtered by RDMS Name 

 

In Figure 220, each rack has unique Group ID name. Using this type of configuration allows more specific rack unit 

selection than a departmental configuration. In this example, only three individual RDMS™ units, B4BTAS1, 

B4BTAS4, B4BTAS6, are visible to the Windows RDMS™ client. 

4.2.7 About Menu 

The About menu, shown in Figure 221, provides access to software version and copyright information as well as 

access to Help files. 

 

 

Figure 221: Remote RDMS™ Client Main Menu Bar, About Menu 

 

The About screen, shown in Figure 222, contains three screen buttons: Application Help, Communications Help, 

and OK. 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

122  Quasonix, Inc. 

 

 

Figure 222: About Screen 

 

Click on the Application Help screen button to display the Rack-Mount RDMS™ Telemetry Receiver User Manual. 

Click on the Communications Help screen button to display the Ethernet troubleshooting flowchart 

(EtherFlowHelp.pdf). 

Click on the OK screen button to close the About screen. 

The “App Instance 1” notation near the top of the screen indicates this is open RDMS Client 1. More than one 

instance of the Client software may be open at once. 

4.2.8 File Menu 

The File menu provides a variety of options: Exit, Save/Load Preset Files, Load RDMS Flash Preset, Save RDMS 

Flash Preset, Turn Off RDMS Unit, and Communications Help. The File menu options are shown in Figure 223. 

 

 

Figure 223: File Menu 

 

4.2.8.1 Save/Load Presets 

Accessed from the File menu, the Save/Load Preset Files option allows the user to save and load settings stored on 

the Windows hard drive or other media. 
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The Save/Load Preset Files window, shown in Figure 224, contains a list of available files. Files are accessed via the 

scroll bar. After selecting an existing preset file name, the user can type a description in the Preset Description 

window. 

On-screen buttons are used to add folders, delete, or rename existing files, or to Save or Load Presets. Clicking on 

the Cancel screen button closes the window without taking any action. 

 

 

Figure 224: Save/Load Preset Files 

 

When the user clicks on the Save Presets screen button, the Save Preset window opens within the window, as shown 

in Figure 225. 

 

 

Figure 225: Save/Load Preset Files, Save Preset Window 
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Type the file name for the new preset file along with the desired description. Click on the Save screen button to 

complete the action, or click on the Cancel screen button, in the Save Preset window, to close only the Save Preset 

window. 

When the user clicks on the Add Folder screen button, the Folder Name window opens within the window, as shown 

in Figure 226. 

 

 

Figure 226: Save/Load Preset Files, Folder Name Window 

 

Type a name for the new folder, as shown in Figure 227, along with the desired description. Click on the Apply 

screen button to add the folder, or click on the Cancel screen button, in the Folder Name window, to close only the 

Folder Name window. 

 

 

Figure 227: Save/Load Preset Files, Folder Name Typed 

 

When the user clicks on the Delete screen button, the Delete window opens within the window, as shown in Figure 

226. Use the scroll bar to select the file to delete. The selected file name displays in the Delete field and the 

associated file description displays in the Preset Description window. The Preset File Valid heading displays in 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

125  Quasonix, Inc. 

 

green to indicate the file type selected is a valid Preset file. Click on the Yes screen button to delete the file, or No to 

exit the Delete window without deleting the file. 

 

 

Figure 228: Save/Load Preset Files, Delete Window 

 

When the user clicks on the Rename screen button, the Rename window opens within the window, as shown in 

Figure 229. Use the scroll bar to select the file to rename. The selected file name displays in the Rename field and 

the associated file description displays in the Preset Description window. The Preset File Valid heading displays in 

green to indicate the file type selected is a valid Preset file. Click on the Apply screen button to rename the file, or 

click on the Cancel screen button in the Rename window to exit the Rename window without renaming the file. 
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Figure 229: Save/Load Preset Files, Rename Window 

 

4.2.8.2 Save or Load RDMS Flash Presets 

Accessed from the File menu, the Load RDMS Flash Preset and Save RDMS Flash Preset options allow the user to 

save and load settings stored on the RDMS™ rack. 

 

 

Figure 230: File Tab, Save/Load Preset Files 

 

4.2.8.2.1 RDMS Save Profile Menu 

When the user selects the Save RDMS Flash Preset option, the menu/window shown in Figure 231 displays. From 

this screen, the user can access the eight (8) storage slots on the RDMS™ rack to save settings. This mirrors the save 

settings on the RDMS™ rack display. 
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Figure 231: RDMS Save Profile Window 

 

Profiles selected are saved to one of the eight (8) storage slots on the RDMS™ rack, not the Windows hard drive. 

This allows the operator to save settings that can be loaded using the front panel Load Profile menus on the rack at a 

later time. 

Click on the Save screen button to save a selected preset or Cancel to exit the Save Profile Menu without taking any 

action. 

4.2.8.2.2 RDMS Load Profile Menu 

When the user selects the Load RDMS Flash Preset option, the menu/window shown in Figure 232 displays. From 

this screen, the user can access the eight (8) storage slots on the RDMS™ rack to load settings. This mirrors the load 

settings on the RDMS™ rack display. 

 

 

Figure 232: RDMS Load Profile Window 
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Profiles selected are loaded from one of the eight (8) storage slots on the RDMS™ rack, not the Windows hard dive. 

This allows the operator to load settings that were saved using the RDMS™ rack LCD menus. 

Click on the Load screen button to load a selected preset or Cancel to exit the Load Profile Menu without taking any 

action. 

4.2.8.3 Turn Off RDMS™ Unit 

Accessed from the File menu, the Turn Off RDMS Unit option, as shown in Figure 233, allows the user to cut power 

to the RDMS™ and turn it Off. 

While on the File menu, click on the Turn Off RDMS Unit option to select it. 

 

 

Figure 233: File Menu, Turn Off RDMS Unit 

 

The RDMS Shutdown Warning window displays, as shown in Figure 234. If you are sure you want to power down 

the RDMS™, click on the Yes screen button. The RDMS™ shuts down. Note the front panel power switch will 

remain in the On position even though the RDMS™ is Off. 

 

 

Figure 234: RDMS Shutdown Warning Window 
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4.2.8.4 Communications Help 

Accessed from the File menu, the Communications Help option, as shown in Figure 235, provides Ethernet 

connection help. 

While on the File menu, click on the Communications Help option to display the Ethernet troubleshooting flowchart 

(EtherFlowHelp.pdf). 

 

 

Figure 235: File Menu, Communications Help 

 

4.3 Advanced Terminal 

The Advanced Terminal window provides access to the individual receiver channel’s underlying serial control 

interface, which is how it receives operational commands from the Remote RDMSTM Client. The serial control 

interface is not recommended for typical Rack-Mount Receiver usage. The Advanced Terminal Settings should only 

be accessed by advanced users. Contact Quasonix customer support before using these options. 

The Advanced Terminal Settings window can be accessed by navigating to the Main Menu and selecting: Remote 

Control > Advanced Terminal, as shown in Figure 236. 

 

 

Figure 236: Remote Control Menu, Advanced Terminal Option 

 

Click on the Advanced Terminal option to display the Start Advanced Terminal Communications window, as shown 

in Figure 237. This window forces the user to acknowledge that all open dialog windows will be closed and blocked 

prior to opening advanced terminal communications. Click on the Yes screen button to continue, or No to exit. 
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Figure 237: Start Advanced Terminal Communications 

 

4.3.1 Advanced Terminal Window 

The Advanced Terminal window, shown in Figure 238, amounts to a portal to the currently selected receiver’s serial 

control interface. This allows the user to communicate to the individual receiver “brick” using its basic command 

protocol. 

 

 

Figure 238: Advanced Terminal Window 
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Note: Access to this serial control interface is provided primarily for debugging purposes. Unlike the standard front 

panel and remote client interfaces, the serial control interface within the Advanced Terminal window is not 

safeguarded from accidental or improper changes to the receiver’s configuration. 

It is strongly recommended that users contact Quasonix Technical Support (Tel: 513-942-1287) prior to using the 

Advanced Terminal serial control interface. 

Changes made within the serial command interface of the Advanced Terminal window are not automatically filtered 

into the Basic Settings window. However, the RRC is able to detect when serial commands are given, at which time 

the green Refresh Settings screen button begin to flash in order to prompt the user. 

 

 

Figure 239: Advanced Terminal Window with User Message 

 

All commands are one or two alphabetic characters, followed by 0, 1, or 2 arguments. If the command is issued with 

arguments, there must be a space after the alphabetic characters. The commands are not case sensitive. 

All commands generate a response of one or more lines. The length of the response depends on the verbosity level 

(set by the VL command – this is an advanced command). The last response line is always the currently selected 

mode (PCMFM, SOQPSK, CPM, or PSK), followed by the character “+” or “>”, depending on the version of the 

firmware. This prompt signifies that the RDMS™ is ready to accept new characters. 

A complete list of available serial commands can be found in section 4.3.2. 
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4.3.2 Tier 0 (PCM/FM), Tier I (SOQPSK-TG), and Tier II (MULTI-H CPM) Commands 

The following table describes all receiver user commands. Listed are the command code, name, description of the 

command, whether specific options must be ordered or the command is standard on all receivers, basic or advanced 

command, and whether the command is restricted to specific waveform modes. 

 

Table 9: Standard and Optional User Commands 

Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

? Help Message Displays abbreviated list of 
available commands 

Standard Basic None 

AD Downconvert 
Antenna 

AD Report the 
downconvert antenna state 

AD 0 Set downconvert 
antenna state to Off 
(Disabled) 

AD 1 Set downconvert 
antenna state to On 
(Enabled) 

**Downconverting antenna 
control only available when 
using a 5-band 
downconverter AND P and C 
bands are enabled. 

**Standard Basic None 

AE AGC Enable Enable or Disable Automatic 
Gain Control (AGC) 

Examples: 

AE Report AGC state 

AE 0 Set AGC state to Off 
(Disabled) 

AE 1 Set AGC state to On 
(Enabled) 

Standard Basic None 

AF Automatic 
Frequency 
Control 

Reports or sets the AFC 
configuration 

Examples: 

AF Report AFC 
configuration 

AF ? Display AF 
command Help 

Standard Advanced None 

AF M Automatic 
Frequency 
Control Mode 

Sets the AFC mode 

Examples: 

AF M 0 Set AFC to Off 

AF M 2 Set AFC to Tracking 

Standard  Advanced None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

AF C Automatic 
Frequency 
Control 
Coefficient 

Sets the AFC coefficient 

Examples: 

AF C 0.00001 Set AFC 
coefficient to 0.00001 (ten 
times slower tracking than 
default) 

Standard Expert None 

AF H Automatic 
Frequency 
Control Hold 

Sets the AFC Hold threshold 

Examples: 

AF H 6 Set AFC to 
automatically hold tracking 
below 6 dB Eb/N0 

Standard Expert None 

AV Manual 
Attenuator 
Control 

Report or set the value of the 
input attenuator 

Valid range is 0 to 124 dB 

Examples: 

AV Report the input 
attenuator setting 

AV 0 Set input attenuator 
to 0 dB 

AV 124 Set input attenuator 
to 124 dB 

Standard Basic None 

BE Bit Error Rate For Bit Error Rate commands 
and information, refer to 
Appendix A, Bit Error Rate 
Testing. 

Standard Advanced 
Command 

None 

BL Break Lock Breaks false locks 

No additional parameters 

Standard Basic PSK 
(legacy) 

BM Bit Rate 
Measurement 

Report bit rate measurement Standard Basic None 

BR Bit Rate Report or set baseband bit 
rate 

Examples: 

BR Report the bit rate 
setting 

BR 5 Set bit rate to 5 
Mbps 

BR 0.6 Set bit rate to 600 
Kbps 

Standard Basic For Asynch 
PSK 

(legacy) 
modes, BR 
A and BR 
B must be 
specified 

separately 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

CC Convolutional 
Decoder 
Enable 

Enables or disables the 
convolutional encoder 

 

Examples 

CC Report convolutional 
encoder state 

CC 0 Set the convolutional 
encoder to Disabled 

CC 1 Set the convolutional 
encoder to Enabled 

K7 Basic PSK 
(legacy) 

CP Clock Polarity Report or set clock polarity 
inversion state 

Examples: 

CP Report the clock 
source state 

CP 0 Set clock inversion 
Off 

CP 1 Set clock inversion 
On 

Standard Basic For Asynch 
PSK  

(legacy) 
modes, CP 
A and CP 
B must be 
specified 

separately 

DE Differential 
Decoder 
Enable 

Report or set differential 
decoding 

 

Examples: 

DE Report the 
differential decoding setting 

DE 0 Set differential 
decoding Off 

DE 1 Set differential 
decoding On 

Standard Basic SOQPSK 

DO DAC Output Reports or sets the DAC 
output configuration 

Examples: 

DO Report DAC output 
configuration 

DO ? Display DO 
command Help 

Standard Advanced None 

DO AM M DAC Output 
AM Multiplier 

Sets the DAC output AM 
scale multiplier 

Examples: 

DO AM M 2.5 Scale AM 
output by 2.5 times normal 

Standard Expert None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

DO AM F DAC Output 
AM Filter 

Sets the DAC output AM 
filter bandwidth 

Examples: 

DO AM F 1.0 Limit AM 
output bandwidth to 1.0 kHz  

Standard Expert None 

DO AGC F DAC Output 
AGC filter 

Sets the DAC output AGC 
filter bandwidth 

Examples: 

DO AGC F 0.1 Limit AGC 
output bandwidth to 0.1 kHz 
(100 Hz) 

Standard Expert None 

DO IQ M DAC Output 
I/Q Multiplier 

Sets the DAC output I/Q 
video scale multiplier 

Examples: 

DO IQ M 2.5 Scale I and 
Q video output by 2.5 times 
normal 

Standard Advanced None 

DP Data Polarity Report or set data polarity 
inversion state 

Examples: 

DP Display the current 
data polarity 

DP 0 Set data polarity to 
NOT inverted (Off) 

DP 1 Set data polarity to 
inverted (On) 

Standard Basic For Asynch 
PSK 

(legacy) 
modes, DP 
A and DP 
B must be 
specified 

separately 

EL Error Limits Reports or sets frequency 
and bit rate error tracking 
limits (the operating range 
over which frequency and bit 
rate can be tracked) 

Examples: 

EL Report the current 
error limits 

Note: These limits should not 
be changed from the default 
settings unless advised by 
Quasonix to do so. 

Standard Advanced None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

EL A 

EL B 

Error Limits, 
Bit Sync 

Sets bit sync (bit rate) error 
tracking limit scale 

Examples: 

EL A 9 Scale bit sync A 
error limit by a factor of 2-9 

Standard Expert PSK 
(legacy) 

EL C Error Limits, 
Carrier 

Sets carrier (frequency) error 
tracking limit scale 

Examples: 

EL C 10 Scale carrier 
tracking error limit by a factor 
of 2-10 

Standard Advanced PSK 
(legacy) 

EL F Error Limits, 
FED 

Sets frequency error tracking 
limit 

Examples: 

EL F 5 Set frequency error 
limit to 2-5 times the bit rate 

Standard Expert ARTM 
(PCM/FM, 
SOQPSK-

TG, 
MULTI-H 

CPM) 

EL T Error Limits, 
TED 

Sets timing (bit rate) error 
tracking limit 

Examples: 

EL T 7 Set timing error limit 
to 2-7 times the bit rate 

Standard Expert ARTM 
(PCM/FM, 
SOQPSK-

TG, 
MULTI-H 

CPM) 

FL Force Lock 
Indication 

Diagnostic tool to force the 
system to indicate locked or 
unlocked 

 

Examples: 

FL Show the force lock 
state 

FL 1 Force lock to On 

FL 0 Force lock to Normal 

FL -1 Force lock to Off 

Standard Advanced 
Command 

None 

FR Frequency Report or set receiver center 
frequency 

Examples: 

FR          Report the 
frequency setting 

FR 2200.5   Set modulation 
to 2200.5 MHz 

Standard Basic None 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

137  Quasonix, Inc. 

 

Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

FS IF Filter Select Report or set the current IF 
filter in the receiver 

FS  Display the 
current IF filter 

FS A  Set IF filter 
to automatic 

FS (0-7) Manually set 
IF filter (not recommended) 

Standard 

 

-14 option 
permits 7 
additional 

filters 

Basic None 

GO Start/Restart Apply changes then reset 
demodulator. 

Initiate demodulation with 
current parameters. This 
command is required when 
setting both the modulation 
and the bit rate. 

Standard Basic None 

HX eXtended 
Help 

Displays a full list of available 
commands 

Standard Basic None 

LD LDPC Decode 
Enable 

Enable, disable, or show the 
current state of the Forward 
Error Correction (FEC) / Low 
Density Parity Check (LDPC) 
decoder 

 

Examples: 

LD Show the current 
decoder state 

LD 1 Enable the LDPC 
decoder 

LD 0 Disable the LDPC 
decoder 

LD Advanced 
Command 

PSK 
(legacy) 

LP Lock Output 
Polarity 

Report or set the active level 
of the lock indication to 
active high or active low 

 

Examples: 

LP Show the current 
lock output polarity 

LP 1 Set the active level 
to high 

LP 0 Set the active level 
to low 

Standard Advanced 
Command 

None 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

138  Quasonix, Inc. 

 

Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

MA Modulations 
Allowed 

Report the available 
waveform modes 
(modulations) available for 
this unit 

Standard Basic None 

MI Modulation 
Index 

Report or Set Modulation 
Index Tracking or Acquire 

Examples 

MI       Report Mod Index 
Track Status 

MI O   Disable Mod Index 
Tracking (Set to h=0.7) 

MI A    Acquire mode enable 

MI A D Sets the maximum 
delta h (indicates a change in 
h defaults to 0.005) 

MI A S Sets the delta h 
settling time defaults to 500 
ms 

MI H    Hold Mod Index 
Tracking at current position 

MI I      Sets Trellis Index 

MI T     Tracking mode 
enable 

MI T H x  Sets the Tracking 
Hold threshold 

Standard Basic PCM/FM 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

MO Modulation Report or set modulation 
setting 

Examples: 

MO     Report the modulation 
setting 

MO 3   Set modulation to 
BPSK 

MO 4   Set modulation to 
QPSK 

MO 5   Set modulation to 
AQPSK 

MO 6   Set modulation to 
AUQPSK 

MO 7   Set modulation to 
OQPSK 

MO 8   Set modulation to 
UQPSK 

MO 9   Set modulation to 
Digital PM (DPM) 

Standard Basic Limited to 
modes 

installed 

NZ NRZ Encoding Report or set the non-return 
to zero (NRZ) value used by 
the receiver 

 

Examples: 

NZ Show the current 
NRZ value 

NZ L Set the NRZ to Level 

NZ M Set the NRZ to Mark 
(1) 

NZ S Set the NRZ to 
Space 

Standard Advanced 
Command 

PCM/FM 
and PSK 
(legacy) 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

OM Output Muting Report or set the operation of 
clock and data output 
muting; clock and data 
outputs can be disabled after 
some period of time without 
lock 

Examples: 

OM Show the output 
muting state 

OM 0 Disables output 
muting 

OM 1 Enables output 
muting 

OM T x Sets the delay 
between loss of lock and 
muted outputs in 
milliseconds from 0 to 46016 

Standard Advanced 
Command 

None 

PA Reset Stored 
Configuration 

Resets all parameters in all 
waveform modes to the 
factory default state 

Refer to Appendix D for 
default values by mode 

Standard Basic None 

PL Input Power 
Level 

Reports or sets the current 
input power level setting 

Examples: 

PL Report the current 
input power level information 
tracking state 

PL 0 Set the current 
power level information 
tracking display to Off 

PL 1 Set the current 
power level information 
tracking display to On 

Standard Advanced 
Command 

None 

PL A Power Level 
Automatic 
Control Mode 

Sets power level automatic 
control mode 

Examples: 

PL A 0 Set the power level 
automatic control mode to 
Software 

PL A 1 Set the power level 
automatic control mode to 
Hardware 

Standard Advanced 
Command 

None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

PL E Input Power 
Level 
Automatic 
Control 

Sets power level automatic 
control enable 

Examples: 

PL E 0 Set the power level 
automatic control enable to 
Off 

PL E 1 Set the power level 
automatic control enable to 
On 

Standard Advanced 
Command 

None 

PL F Power Level 
Filter 

Sets the average and 
adjusted power level filter 
coefficient 

Valid range is 1 to 16 

Example: 

PL F 5  Set the power level 
filter coefficient to 5 

Standard Advanced 
Command 

None 

PL M Power Level 
Measurement 
Type 

Sets the power level 
measurement type 

Examples: 

PL M 0 Set the power level 
measurement type to Total 
Power 

PL M 1 Set the power level 
measurement type to Signal 
Power  

Standard Advanced 
Command 

None 

PL R Power Level 
Register 

Reports the power level 
register set state 

Sets the power level register 
to a value 

Example: 

PL C W reg value 

where 

C is Channel 0 or 1 

reg is hex register index 00 
to 03 

value is 32 bit hex value to 
write to the register 

Standard Advanced 
Command 

None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

PL S Power Level 
Scale 

Sets power level scale value 

Valid range is 0.000 to 7.996 

Example: 

PL S 2.517  Set the 
power level scale value to 
2.517 

Standard Advanced 
Command 

None 

PL T Power Level 
Target 

Sets power level target value 

Valid range is -37.100 to 
11.060 

Example: 

PL T 3.400 Set the 
power level target value to 
3.400 

Standard Advanced 
Command 

None 

PN Phase Noise 
Compensation 

Report or set phase noise 
compensation state 

Examples: 

PN     Report the phase 
noise compensation state 

PN 0   Set phase noise 
compensation to Off 

PN 1   Set phase noise 
compensation to On 

Standard Basic PCM/FM 

PR Reset Defaults Restores factory default 
parameters for the unit 

Default is currently the 
lowest number modulation 
supported by the transmitter 
with the selected band and 
frequency limits 

Standard Advanced 
Command 

None 

QT Query 
Temperature 

Report the temperature in 
degrees Celsius 

Standard Basic None 

RN Derandomizer 
State 

Report or set the 
derandomizer state 

Examples: 

RN     Report the 
derandomizer state 

RN 0   Set the derandomizer 
Off 

RN 1   Set the derandomizer 
On 

Standard Basic None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

SN Show Serial 
Number 

Report the serial number for 
the unit  

Standard Basic None 

SV Save 
Parameters 

Saves the current 
parameters in non-volatile 
memory, including 
frequency, modulation, bit 
rate, data polarity, clock 
polarity, AGC state, verbosity 
level, etc. 

Standard Basic None 

SY System Status 
Tracking 

Displays the system status of 
the receiver 

The first argument specifies 
the period, in milliseconds, 
between status updates. 
Zero (0) disables continuous 
monitoring. 

The second argument 
specifies the number of 
status lines between header 
output. 

Examples: 

SY Displays current 
status report settings 

SY 5 Sets status output 
period to 5 milliseconds 

SY 5 100 Sets status 
header output once every 
100 status updates 

Standard Advanced 
Command 

Available 
for all 

EXCEPT 
PSK 

(legacy) 

TO Tape Output Displays the status of the 
Tape Output option 

Example: 

TO Displays current tape 
output status settings 
(enabled/disabled and output 
frequency) 

Standard Advanced 
Command 

PCM/FM 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

TO F Tape Output 
Frequency 

Sets the carrier frequency of 
the pre-detection complex 
Tape Output 

Examples: 

TO F 0 Sets the Tape 
Output Frequency to Off 
(carrier frequency = 0 MHz) 

TO F 1 Sets the Tape 
Output Frequency to a 
specific frequency number 

Value range is 0.000 to 
20.000 MHz 

Standard Advanced 
Command 

PCM/FM 

TO T Tape Output 
Source 

Sets the test output to a 
Tape source; 

Enables or Disables the pre-
detection complex baseband 
as the tape output source 

 

When enabled (T=1), pre-
detection complex baseband 
is selected as the source of 
data to send on I and Q 
analog outputs 

When disabled (T=0), the I 
and Q analog outputs 
(frequency/phase 
information) are restored to 
their normal defaults which 
vary by mode 

 

Examples: 

TO T 0 Sets the Tape 
Output Source to disabled 

TO T 1 Sets the Tape 
Output Source to enabled 

Standard Advanced 
Command 

PCM/FM 

VE Version Report the current Firmware 
(software) version 
information for the receiver 

Standard Basic None 
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Mnemonic Name Description 

 

Option (s) 
Required 

Command 
Level 

Mode 
Restriction 

VF Viterbi Forget 
Factor 

Report or set the Viterbi 
forget factor, on a scale from 
0.01 – 0.99 

Examples: 

VF       Report the Viterbi 
forget factor 

VF 0.04  Set the Viterbi 
forget factor to 0.04 

VF 0.62  Set the Viterbi 
forget factor to 0.62 

Standard Advanced 
Command 

PCM/FM 

VL Verbosity 
Level 

Report or set verbosity level, 
on a scale of 0 – 9 

Examples: 

VL     Report the verbosity 
level 

VL 0   Set the verbosity level 
to 0 

VL 5   Set the verbosity level 
to 5 

Standard Advanced 
Command 

None 

ZZ Show Options Displays the current 
hardware configuration and 
options on the receiver 

Standard Advanced 
Command 

None 

 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

146  Quasonix, Inc. 

 

4.4 Operational Priority 

With two different user interfaces available—direct front panel operation and remote control—priority must be 

given to one or the other to maintain device stability. The following table outlines the default prioritization: 

 

Table 10: Interface Prioritization 

Scenario Priority 

Remote RDMS 
Client 

Front Panel 
Control 

Remote RDMS Client is unopened  X 

Remote RDMS Client is open, but 
unused / static 

 X 

Remote RDMS Client is opened, and 
settings are actively being updated 

X  

 

When the client is open and actively being used, controls on the front panel are temporarily disabled for the local 

user. If the local user presses a key, the settings LCD on the receiver’s front panel will display the following 

message: 

Remote Client Active 

Press ‘SEL UNIT’ to override. 

 

If the local user wishes to override the client, press the Select Unit key on the front panel keypad. Control to the 

front panel is reinstated. 

4.5 Troubleshooting Remote Client Operation 

4.5.1 Remote Client Cannot Find Rack with a One to One Cable 

This issue may be related to network sharing on the Windows computer. 

If a one to one cable is used and the remote client cannot find the RDMS™ rack, check the network sharing 

settings on the Windows computer by doing the following: 

1. Access the Control Panel from the Start Menu. The Start Menu is usually the first icon on the 

bottom of the PC screen--a circle with four windows in it. Click on Control Panel (Figure 240). 
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Figure 240: Start Menu - Control Panel 

 

2. When the Control Panel screen displays, click on the Network and Sharing Center selection 

(Figure 241). In some versions of the Windows operating system, there is an additional folder 

layer such as Control Panel \ All Control Panel Items \ Network and Sharing Center. 

 

 

Figure 241: Control Panel - Network and Sharing Center 
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3. The Network and Sharing page may look different from one version of Windows to another. If the 

network setting is "Public Network", change it to "Work Network". 

This should resolve the issue. If you cannot access your network settings, check with your IT 

administrator. 

4.5.2 Graphics in the Remote Client are not Rendering Correctly on a PC using Windows 7 

This issue may be caused by a Windows 7 operating system using the Windows XP graphics scaling 

setting. 

To change the scaling option: 

1. Access the Control Panel from the Start Menu. The Start Menu is usually the first icon on the 

bottom of the PC screen--a circle with four windows in it. Click on Control Panel. 

 

 

Figure 242: Start Menu - Control Panel 

 

2. When the Control Panel screen displays, click on the Display selection, as shown in Figure 243. 
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Figure 243: Control Panel, Display Selection 

 

3. The Display window contains an options menu. Click on Set custom text size (DPI), as shown in 

Figure 244. 

 

 

Figure 244: Display Window, Set Custom Text Size Option 

 

A Custom DPI Setting window displays, as shown in Figure 245. 
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Figure 245: Custom DPI Setting Window 

 

4. Click on the check mark next to Use Windows XP style DPI scaling to remove the option. 

By default the scale setting is 100%. You can use large fonts (above 100%) but the setting for 

Windows XP scaling MUST be unchecked. 

5. Click on the OK button to save the settings and close the Custom DPI Setting window. 

The Remote Client graphics should now render correctly. If there still seems to be an issue, 

contact Quasonix. 
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5 Performance Specifications 

5.1 RF Input 

Each receiver channel is available in multiple band configurations, as shown in Table 11. 

 

Table 11: Band Codes and Frequencies 

Model Number 
Code 

Band Minimum 
Frequency 

Maximum 
Frequency 

Default 
Frequency 

P P band (UHF) 400.0 MHz 1150.0 MHz 400.0 MHz 

L Lower L 1435.5 MHz 1534.5 MHz 1435.5 MHz 

U Upper L 1755.0 MHz 1850.0 MHz 1755.0 MHz 

S S 2200.5 MHz 2394.5 MHz 2200.5 MHz 

C C “Low” 4400.0 MHz 5150.0 MHz 4400.0 MHz 

G P and S (Dual band) 400.0 MHz and 
2200.5 MHz 

1150.0 MHz and 
2394.5 MHz 

2200.5 MHz 

F S and C (Dual band) 2200.5 MHz and 
4400.0 MHz 

2394.5 MHz and 
5150.0 MHz 

2200.5 MHz 

M Lower L, Upper L, and 
S (Tri-band) 

1435.5 MHz 2394.5 MHz 1435.5 MHz 

R P, Full-L, and S 

(Quad band) 

400.0 MHz 2394.5 MHz 1435.5 MHz 

Q Full L, S, and C 

(Quad band) 

1435.5 MHz 5150.0 MHz 1435.5 MHz 

E P, Full L, S, and C 

(Five band) 

400.0 MHz 5150.0 MHz 400.0 MHz 

 

The input impedance is 50 ohms. 

5.2 Power 

The rack-mount receiver requires 100 to 240 VAC, 50/60 Hz power. 

5.3 RF Frequency Error 

By default, the RDMS™ is capable of acquiring a signal with a frequency error of up to ±100 kHz. 

5.4 Bit Error Rate 

The RDMS™ meets the following BER limits, when tested with a signal source, which complies with IRIG 106-05. 
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Table 12: RDMS™ BER Specifications 

BER Maximum Eb/N0 (dB) 

PCM/FM, Tier 0 SOQPSK-TG, Tier I Multi-h CPM, Tier II 

10-3 7.5 9.5 11.0 

10-4 9.0 11.5 12.5 

10-5 10.0 13.0 13.5 

10-6 11.0 14.5 14.5 

 

Typical BER performance, plotted in Figure 48, is significantly superior to that tabulated above. 

 

 

Figure 246: BER Performance for Tier 0, I, and II 

 

5.5 Synchronization 

The RDMS™ offers very fast, reliable acquisition, even at very low signal to noise ratio.  Synchronization time is a 

function of modulation type and IF frequency error. Typical SOQPSK results (from 10,000 synchronization trials) 

are shown in Figure 247. 
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Figure 247: Synchronization Time at Various Signal-to-Noise Ratios 
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6 Maintenance Instructions 

The Rack Mount Receiver requires no regular maintenance, and there are no user-serviceable parts inside. 
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7 Product Warranty 

The Rack Mount Receiver carries a standard parts and labor warranty of one (1) year from the date of delivery. 

7.1 Quasonix Limited Warranty Statement 

This Limited Warranty Statement (this “Limited Warranty”) applies to all hardware and software products and 

internal components of such products (the “Products”) sold by Quasonix, or its representatives, authorized resellers, 

or country distributors (collectively referred to herein as “Quasonix”).  EXCEPT AS EXPRESSLY SET FORTH IN 

THIS LIMITED WARRANTY, QUASONIX MAKES NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, 

INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 

PURPOSE WITH RESPECT TO ANY PRODUCTS SOLD BY IT. Quasonix expressly disclaims all warranties and 

conditions not stated in this limited warranty. There are no warranties which extend beyond the description on the 

face hereof.  Capitalized terms not otherwise defined herein shall have the meaning set forth in those certain General 

Terms and Conditions of Sale for Standard Product, as amended from time to time. 

Quasonix warrants to customer that for one (1) year from the date of shipment of the Products by Quasonix (the 

“Warranty Period”), such Products purchased from Quasonix or its authorized affiliate will materially conform to 

the specifications set forth in the applicable Quasonix Specifications, if any, and are free from defects in materials 

and workmanship under normal use during the Warranty Period. As used herein, “normal use” means the intended 

use of the Products for which it was designed by Quasonix.  

This Limited Warranty extends only to the original purchaser of the Products and is not transferable to anyone who 

obtains ownership of the Products from the original purchaser. 

Quasonix’s software, whether incorporated into the Products or sold separately, is warranted solely to the extent that 

problems or “bugs” are found in the software and affect the functional operation of the Products. At no time shall 

requests for changes in the software architecture or visual esthetics be considered a warranty item. 

The Products are manufactured using new materials only. Replacement parts may be new or equivalent to new. 

Replacement parts are warranted to be free from defects in material or workmanship for thirty (30) days or for the 

remainder of the Warranty Period of the Products in which they are installed, whichever is longer. 

During the Warranty Period, Quasonix will repair or replace the defective Products. All components or hardware 

products removed from the Products under this Limited Warranty become the property of Quasonix. All warranties 

are limited to the repair or replacement of the Products. 

In no event shall Quasonix be liable for any special, consequential, incidental or indirect damages of any kind, 

including, without limitation, loss of profits, loss of data, “down-time,” loss of use or damage to other equipment, or 

personal injury or death, whether or not Quasonix has been advised of the possibility of such loss. 

Notwithstanding anything to the contrary herein, Quasonix’s entire liability hereunder from any cause whatsoever 

and regardless of the form of action shall be limited to the amount actually received by Quasonix. 

Quasonix shall not be liable for a breach of the warranty set forth in this Limited Warranty unless: (i) the customer 

gives written notice of the defect, reasonably described, to Quasonix’s Contracts Administrator within thirty (30) 

days of the time when customer discovers or ought to have discovered the defect and obtains a Return Materials 

Authorizations (“RMA”) number; (ii) Quasonix is given a reasonable opportunity after receiving the notice to 

examine such Products and customer (if requested to do so by Quasonix) returns such Products to Quasonix's 

facility in Moorpark, CA, unless otherwise approved by Quasonix; and (iii) Quasonix reasonably verifies customer's 

claim that the Products are defective. 

Subject to the foregoing, with respect to any such Products during the Warranty Period, Quasonix shall, in its sole 

discretion, either: (i) repair or replace such Products (or the defective part) or (ii) credit or refund the price of such 
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Products at the pro rata contract rate provided that, if Quasonix so requests, customer shall, at Quasonix's expense, 

return such Products to Quasonix. 

The customer is responsible for all costs associated with packaging and shipping of the defective Products to 

Quasonix’s facility and clearly marking or affixing the given RMA number on the shipping label. Quasonix is not 

responsible for any loss or damage during shipment to Quasonix’s facility. Following repair or replacement of 

covered Products, Quasonix will assume responsibility for the costs associated with the return of the material to the 

customer to an address provided by the customer. Notwithstanding the foregoing, items returned to Quasonix’s 

facility and found to be operational or otherwise not covered by this Limited Warranty shall be returned to the 

customer at the customer’s expense. 

This Limited Warranty does not apply to expendable parts, such as cables, lamps, fuses, connectors, etc. This 

Limited Warranty does not extend to any Products which have been damaged or rendered defective (a) as a result of 

accident, misuse, abuse, or external causes; (b) by operation outside the usage parameters stated in the user 

documentation that shipped with the  Products; (c) as a result of a failure to follow the instructions in the Operations 

& Maintenance Manual (d) by the use of parts not manufactured or sold by Quasonix; or (e) by modification or 

service by anyone other than (i) Quasonix, (ii) an Quasonix authorized service provider, or (iii) your own installation 

of end-user replaceable Quasonix or Quasonix approved parts if available for the Products in the servicing country. 

THE TERMS OF THE WARRANTIES CONTAINED HEREIN DO NOT IN ANY WAY EXTEND TO ANY 

PRODUCT OR PART THEREOF OR SOFTWARE MATERIALS WHICH WERE NOT MANUFACTURED BY 

SELLER OR PREPARED BY SELLER OR ANY OF ITS AFFILIATES. 

These terms and conditions constitute the complete and exclusive warranty agreement between the customer and 

Quasonix regarding the Products purchased. This Limited Warranty is applicable in all countries and may be 

enforced in any country where Quasonix or its authorized affiliates offer warranty service subject to the terms and 

conditions set forth in this Limited Warranty. 

These terms and conditions supersede any prior agreements or representations (including representations made in 

Quasonix sales literature or advice given to the customer by Quasonix or an agent or employee of Quasonix) that 

may have been made in connection with the purchase of the Products. No change to the conditions of this Limited 

Warranty is valid unless it is made in writing and signed by an authorized representative of Quasonix. 

7.1.1 Extended Warranties 

Extended warranties or extra coverage are available upon request. Please contact Quasonix for details and pricing. 

THE REMEDIES SET FORTH IN THIS LIMITED WARRANTY STATEMENT SHALL BE THE 

BUYER'S SOLE AND EXCLUSIVE REMEDY AND SELLER'S ENTIRE LIABILITY FOR ANY 

BREACH OF THE LIMITED WARRANTY SET FORTH HEREIN. 

 

052217mbb002 
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8 Technical Support and RMA Requests 

In the event of a product issue, customers should contact Quasonix via phone (1-513-942-1287) or e-mail 

(support@quasonix.com) to seek technical support. If the Quasonix representative determines that the product issue 

must be addressed at Quasonix, a returned materials authorization (RMA) number will be provided for return 

shipment. 

Authorized return shipments must be addressed in the following manner: 

 

Quasonix, Inc. 
ATTN: Repair, RMA # 

6025 Schumacher Park Drive 
West Chester, OH 45069 

 

To ensure that your shipment is processed most efficiently, please include the following information with your 

product return: 

• Ship To – Company name, address, zip code, and internal mail-drop, if applicable 

• Attention/Contact person – Name, Title, Department, Phone number, email address 

• Purchase Order Number – If applicable 

• RMA Number – provided by the Quasonix representative 

 

Please note that Quasonix reserves the right to refuse shipments that arrive without RMA numbers. 
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9 Appendix A – Bit Error Rate Testing 

There is a separate BERT for each data path in the receiver (0 main channel, 1 combiner channel). By default all 

commands are targeted to the current “tracking channel” (TC command), 0 or 1. If the tracking channel is set to 2 

(tracking both channels), then the channel must be explicitly specified. 

The results of the test can be displayed using the BE command with no parameters or a continuous display can be 

produced using BE D 1. BE D 0 turns off the continuous display. 

 

Table 13: Bit Error Rate Serial Commands 

Mnemonic Name Description 

BE ? Bit Error Rate Help Provides help for using the bit error rate commands 

BE [c] Bit Error Rate Status Report bit error rate status 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

 

Examples: 

BE Show the bit error rate status 

BE 1 Show the status of channel 1 

BE D Bit Error Rate Status 
Continuous 

Report a continuous display of bit error rate status 

 

Examples: 

BE D 0  Show continuous bit error rate status is Off 

BE D 1  Show continuous bit error rate status is On 

BE [c] P n Set Bit Error Test 
Pattern 

Sets bit error test pattern 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

P indicates a preset or fixed pattern length 

 where 'n' is one of: 

 PN6, PN9, PN11, PN15, PN17, PN20, PN23, PN31 

 or, for a fixed pattern length of 2 to 32 

 (fixed patterns are automatically determined) 
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Mnemonic Name Description 

BE [c] T n Set Bit Error 
Measurement Type 

Sets bit error measurement type 

The test type can be configured to run continuously or stop 
when either a time limit, bit count, or error count has been 
reached. The error count limit guarantees a minimum number 
of errors. 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

T indicates type 

 where 'n' is one of the following: 

 C = continuous (clears limits) 

 T x = time limit 

  where 'x' is between 0 and 4.29497E+06 
  seconds 

 B x = bit limit 

  where 'x' is between 0 and 9.3825E+13 

 E x = error limit 

  where 'x' is between 0 and 3.1275E+13 

BE G n Set Bit Error 
Measurement Gating 

Sets bit error measurement gating 

The test can be configured to make a single measurement or, 
when a time limit, bit count, or error count is set, automatically 
repeat the test. 

 

Examples: 

BE G S  S indicates Single 

BE G R  R indicates Repeat 
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Mnemonic Name Description 

BE [c] M Measurement Enable Starts or stops bit error measurement (toggle command) 

If a time limit, bit count, or error count limit is set and the limit 
has been reached (enabled but not running) the BERT is 
restarted. 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

 

Examples: 

BE M Enter command once to Start bit error measurement, 
 current tracking channel 

BE M Enter command again to Stop bit error measurement 

 current tracking channel 

BE 1 M Enter command once to Start bit error measurement, 
 for channel 1 

BE [c] R Hardware Bit Error 
Register Display 

Reports the bit error register status 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

 

Example: 

BE 1 R  Report bit register state for channel 1 

BE [c] W 
reg value 

Set Hardware Bit Error 
Register 

Sets hardware bit error register 'reg' to 'value' 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

 

 ‘reg’ is hex register index 00 to 0a 

 ‘value’ is 32 bit hex value to write to register 

 

The Hardware Bit Error Register Display reports the current status of the bit error rate test (BERT). 

A column header is displayed every ten rows. 

The 'E' column indicates the BERT is enabled by displaying a pound sign '#'. If the BERT is not enabled, this 

column is blank. 

The 'R' column indicates the BERT is actually running and making a measurement by displaying a '!'. If the BERT is 

not running, this column is blank. 
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The BERT can be enabled, but not running, in the case of a time, bit, or error count limit. 

An asterisk '*' after the error rate column indicates that the data is inverted. If the display is continuous and a time, 

bit, or error limit is set with repeating gating, the display shows the end of the test by displaying '>>>' in the first 

three columns. 

The following shows an example display with a five (5) second repeating test. 

 

E R             Time       Bit Count     Error Count      Error Rate 

# !   0:00:00:03.772       3.773e+07               2       5.301e-08* 

# !   0:00:00:04.023       4.023e+07               2       4.971e-08* 

# !   0:00:00:04.276       4.276e+07               2       4.677e-08* 

# !   0:00:00:04.527       4.528e+07               2       4.417e-08* 

# !   0:00:00:04.779       4.780e+07               2       4.184e-08* 

>>>   0:00:00:05.000       5.000e+07               2       4.000e-08* 

# !   0:00:00:00.251       2.512e+06               0       0.000e+00* 

# !   0:00:00:00.503       5.032e+06               0       0.000e+00* 

# !   0:00:00:00.757       7.574e+06               2       2.641e-07* 

# !   0:00:00:01.011       1.011e+07               2       1.978e-07* 

# !   0:00:00:01.263       1.264e+07               2       1.582e-07* 

 

9.1 Test Noise Commands 

Digitally generated additive white Gaussian noise (AWGN) can be injected in the demodulator for test purposes. 

This noise can exhaust most or all of the demodulator's error-free signal processing margin so that small 

imperfections in the received signal will be visible as an increase in the bit error rate. 

The noise level is calibrated relative to an extremely accurate measurement of the input signal level.  This 

measurement will be most accurate when the received signal has a high signal-to-noise ratio. Therefore, input signal 

levels above -70 dBm are generally recommended. Due to the available dynamic range of the demodulator signal 

processing path and the faithful representation of the AWGN, noise samples may be clipped, especially at or below 

0 dB Eb/N0. 

Note that the noise is injected following downconversion to baseband but before demodulation. Therefore, the noise 

will affect demodulator output signals, including video outputs and the front panel display (eye diagram or 

constellation), but it will not change measurements of the input signal (signal strength and signal quality). 

  



 
Rack-Mount RDMSTM Telemetry Receiver 

 

162  Quasonix, Inc. 

 

 

Table 14: Test Noise Commands 

Mnemonic Name Description 

TN ? Test Noise Help Provides help for using the test noise commands 

TN [c] Test Noise Status Report test noise status 

[c] is optional and indicates channel 0 or 1 

 If channel is omitted, the current tracking channel (TC) 
 is used 

 If TC is 2, a channel number is required 

 

Examples: 

TN Show the test noise status 

TN 1 Show the status of channel 1 

TN [c] E 'n' Enable/Disable Test 
Noise 

Turns the test noise output On or Off 

 If 'n' is 0, test noise is Off 

 If 'n' is 1, test noise is On 

Example: 

TN 1 E '1' Test noise is On for channel 1 

TN [c] N n Set Test Noise Level Sets the test noise output level in Eb/N0 

Range for n is -10.00 Eb/N0 to +50.00 Eb/N0 

Example: 

TN 1 N 20.00 Set test noise output level for channel 1 to 
  20.00 Eb/N0 
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10 Appendix B – AGC Compensation 

10.1 AM Menu 

Automatic Gain Control (AGC) Compensation adjusts the AM output to neutralize residual low-frequency 

amplitude variation due to inherent lag in the AGC. This process provides excellent decoupling between the AGC 

tracking action and the AM output.  However, it adds delay to the AM output, so AGC Compensation may not be 

suitable for all antenna control applications. 

10.1.1 Recommended Settings 

Recommended AM and AGC settings depend on three primary parameters: ACU scan type (conical or e-scan), 

ACU scan rate, and ACU control loop bandwidth. Table 15 describes recommended settings based on these 

parameters: 

 

Table 15: Recommended AM/AGC Settings 

 AGC Time Constant AM Bandwidth AGC 
Compensation 

Conical scan, slow loop 0.875 / ScanRate 3 * ScanRate ON 

Conical scan, fast loop 3 / ScanRate 3 * ScanRate OFF 

E-scan 0.875 / ScanRate 9 * ScanRate (1) ON 

(1) up to a maximum of 50 kHz 

In Table 15, ScanRate is the antenna scan rate. It is most convenient if the calculations are performed using a scan 

rate measured in kHz, so the resulting AGC Time Constant is in units of ms and the resulting AM Bandwidth is in 

units of kHz. 

For example, suppose a conical scan system with slow loop tracking has a scan rate of 30 Hz (0.030 kHz). This 

system has a recommended AGC Time Constant of 0.875 / 0.030 = 29 ms and an AM Bandwidth of 3 * 0.030 = 

0.09 kHz, with AGC Compensation ON. 

The distinction between “slow loop” and “fast loop” is generally not simple to infer. An empirical approach would 

be to assume slow loop, gaining the benefits of AGC Compensation if possible. The fast loop settings would be used 

if the slow loop settings do not provide stable antenna tracking. 

10.2 SNR Estimator (Advanced Menu) 

SNR estimation is used primarily to achieve proper channel weighting by the optimal ratio diversity pre-detection 

combiner. There are two algorithms available to estimate SNR: AGC and DSP. Under normal conditions, with 

proper AGC zeroing, these two algorithms provide substantially similar results. 

The AGC-based SNR estimator measures received power relative to the AGC zero point (i.e., noise floor). This 

estimation is insensitive to modulation and does not distinguish between intended signal and interfering signal. This 

selection is recommended for unknown signals or for signals with modulation that is not constant-envelope (for 

example, unshaped PSK). However, an accurate AGC zeroing process is required for accurate results. 

The DSP-based SNR estimator numerically measures received power relative to noise power at the demodulator 

input, assuming the signal power is attributable to constant-envelope modulation and the noise power is attributable 

to additive white Gaussian noise. This selection is recommended for ARTM modulation types (Tier 0, I, and II) or 

when an accurate AGC zeroing process is not feasible. 
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11 Appendix C – Phase Noise Compensation 

11.1 Trellis Demodulation Basics 

Legacy Single-Symbol Detection: 

• Uses basic Limiter-Discriminator operation 

• Frequency in this bit above nominal → data = 1 

• Frequency in this bit below nominal → data = 0 

• Makes no use of adjacent symbols for error correction 

Trellis Detection: 

• Uses the phase tree for data detection 

• Uses adjacent symbols to help decide on “iffy” bits 

• Improves BER performance by 3.5 to 5.0 dB 

 

The Phase Tree shown in Figure 248, shows all of the possible paths the phase trajectory can take over a period of 

seven bits. Figure 249 shows the two unique paths, based on whether the second bit is a 1 or 0. 

 

 

Figure 248: Ideal PCM/FM Phase Tree (h = 0.7) 
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Figure 249: Phase Trajectory Never Forgets 

 

11.1.1 Trellis Demodulation Summary 

The basic premise of trellis demodulation is that the signal from the transmitter follows a known path through the 

phase tree. When the demodulator knows this, it can use a sequence of several symbols to help make better decisions 

about each individual bit. This process improves BER performance by about 3.5 to 5 dB over conventional FM 

detection. However, this assumes that the transmitter is really following the "known" and "correct" phase tree, and 

this assumption is NOT always true. 

High phase noise can reduce the trellis detection gain because phase noise corrupts the tree. The following figures 

illustrate the differences in trellis detection gain depending on the amount of phase noise introduced. 

  

Figure 250: Trellis Detection Gain with Zero to Minimum Phase Noise 
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Figure 251: Trellis Detection Gain with Significant to Severe Phase Noise 

 

11.2 Phase Noise Impact 

Trellis demodulation is based on the assumption that the signal is following a predictable path through the trellis. If 

this is not true (due to high phase noise), then a trellis demodulator cannot provide the expected performance gain. 

• Many legacy analog transmitters (a simple modulated VCO) have high phase noise. 

• Vibration often further increases phase noise. 

• Phase noise is generally more damaging at low bit rates. 

• Phase Noise Compensation (PNC) gives back some of the trellis detection gain, by shortening the trellis 

observation span. 

11.3 Clock Jitter Impact 

Many older PCM encoders are susceptible to large inaccuracies in clock rate or have clock stability issues, 

especially under harsh vibration conditions. While the RDMS is capable of tracking static clock rate errors as large 

as 1000 ppM, excessive jitter causes the integrated bit sync to lose lock. Enabling the PNC mode opens the tracking 

loop bandwidth to accommodate for these issues. This increase in bandwidth does have a tradeoff. A wider tracking 

range allows the RDMS to deal with the additional jitter, but it may also increase synchronization times slightly, and 

slightly increase the minimum SNR at which the RDMS declares lock. 

11.4 When to Use PNC 

There is no bullet-proof test for whether PNC is needed, but there are good indicators. Turn on PNC if: 

• The demodulator is struggling to lock, even with good Signal to Noise Ratio (SNR). ("Good" SNR means 

the Quality bar is above one-quarter height.) 

• The eye pattern NEVER looks “clean,” as in Figure 252 

• Symptoms get worse when the transmitter is under vibration 

• Symptoms get worse at low bit rates 
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Figure 252: "Clean" Eye Pattern 

 

11.5 Know Your Transmitter 

If you know the brand and type of transmitter, these tips can help determine when to use PNC. 

If your transmitter was manufactured by these companies, PNC should be OFF: 

• Quasonix – guaranteed 

• Nova Engineering – highly likely 

• L3 – probably, but digital transmitters only 

If the transmitter was manufactured by the companies below, PNC should be ON: 

• Microwave Innovations 

• Emhiser 

• Southern California Microwave 

• L3 (analog transmitters) 
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12 Appendix D – Factory Reset Values 

When a reset command is activated, the frequency defaults to the lowest valid frequency for the lowest authorized 

band on the unit. The reset priority is: 

1. QPSK 

2. PCM/FM 

3. SOQPSK 

4. Multi-h CPM 

Reset values for each mode are listed in the following tables. 

 

Table 16: QPSK Factory Reset Values 

Parameter Reset State 

Bit Rate 1 

Modulation Scaling N/A 

Clock Polarity Normal 

Data Polarity Normal 

Derandomizer Disabled 

Differential Decoder N/A 

IF Filter Auto 

Downconvert Antenna Disabled 

AGC Enabled 

Convolutional Decoder Disabled 

Lock Output Polarity Active High 

NRZ Encoding NRZ-L 

Output Control Default 

Output Muting Disabled 

Phase Noise Compensation Disabled 

Tape Output Disabled 
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Table 17: PCM/FM Factory Reset Values 

Parameter Reset State 

Bit Rate 1 

Modulation Scaling Tracking 

Clock Polarity Normal 

Data Polarity Normal 

Derandomizer Disabled 

Differential Decoder N/A 

IF Filter Auto 

Downconvert Antenna Disabled 

AGC Enabled 

Convolutional Decoder Disabled 

Lock Output Polarity Active High 

NRZ Encoding NRZ-L 

Output Control Default 

Output Muting Disabled 

Phase Noise Compensation Disabled 

Tape Output Disabled 
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Table 18: SOQPSK Factory Reset Values 

Parameter Reset State 

Bit Rate 1 

Modulation Scaling N/A 

Clock Polarity Normal 

Data Polarity Normal 

Derandomizer Disabled 

Differential Decoder Enabled 

IF Filter Auto 

Downconvert Antenna Disabled 

AGC Enabled 

Convolutional Decoder N/A 

Lock Output Polarity Active High 

NRZ Encoding N/A 

Output Control Default 

Output Muting Disabled 

Phase Noise Compensation Disabled 

Tape Output Disabled 
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Table 19: Multi-h CPM Factory Reset Values 

Parameter Reset State 

Bit Rate 1 

Modulation Scaling N/A 

Clock Polarity Normal 

Data Polarity Normal 

Derandomizer Disabled 

Differential Decoder N/A 

IF Filter Auto 

Downconvert Antenna Disabled 

AGC Enabled 

Convolutional Decoder N/A 

Lock Output Polarity Active High 

NRZ Encoding N/A 

Output Control Default 

Output Muting Disabled 

Phase Noise Compensation Disabled 

Tape Output Disabled 
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13 Appendix E – Special Considerations for International Applications 

Because formatting standards may differ by region or country, Windows software may set defaults for your PC to 

values not expected by the RDMS™ software. Changing these settings, as described in this section, should resolve 

regional connectivity issues. 

13.1 IP Address Separator 

An incorrect IP address separator results in the RDMS™ Client being unable to connect to the PC. Any separator 

other than a period ( . ) is unrecognizable by the RDMS™ software. Some regions use a comma ( , ) instead of a 

period to separate the fractional part of decimal numbers. For example: 

123,456,789 

instead of 

123.456.789 

Typically, changing the Regional Settings option for the list separator on the PC from a comma to a period will 

resolve the problem. 

To change the settings on a Windows 7 machine: 

1. Access the Control Panel from the Start Menu. The Start Menu is usually the first icon on the bottom of the 

PC screen--a circle with four windows in it. Click on Control Panel. 

 

 

Figure 253: Start Menu - Control Panel 
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2. When the Computer Settings window displays, click on the Region and Language selection (labeled 2 in 

Figure 254). This causes the Region and Language window to display (labeled 3 in Figure 254). 

 

 

Figure 254: Region and Language Selection 

 

3. In the Region and Language window, click on the Additional Settings button. The Customize Format 

window displays (shown in Figure 255). 
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Figure 255: Customize Format Window 

 

4. Use the down arrow in the List Separator column to change the comma to a period. Click on the OK button 

to complete the change and close the window. 

5. Click on the OK button in the Region and Languages window to close the window. The separator in the IP 

list should now be the period ( . ). 

 



 
Rack-Mount RDMSTM Telemetry Receiver 

 

175  Quasonix, Inc. 

 

14 Appendix F – Acronym List 

Acronym Description 

AGC Automatic Gain Control 

AM Amplitude Modulation 

AQPSK Variant of Quadrature Phase Shift Keying 

ARTM Advanced Range Telemetry 

AUQPSK Variant of Quadrature Phase Shift Keying 

BER Bit Error Rate 

BNC Bayonet Neill-Concelman Connector (RF Connector) 

BPSK Binary Phase Shift Keying 

CD Compact Disk 

CPM Continuous Phase Modulation 

DB-9 D-subminiature 9 pin Serial Connector 

DC Diversity Combiner 

DHCP Dynamic Host Configuration Protocol 

DPM Digital Phase Modulation 

FPGA Field Programmable Gate Array 

IF Intermediate Frequency 

IP Internet Protocol 

kbps Kilobits per second 

KHz Kilohertz 

LCD Liquid Crystal Display 

mbps Megabits per second 

MCX Snap on subminiature connector 

MHCPM multi-h Continuous Phase Modulation 

MHz Megahertz 

N (connector type) Threaded RF connector 

OQPSK Offset Quadrature Phase Shift Keying 

PCMFM Pulse Code Modulation/Frequency Modulation 

PM Phase Modulation 
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Acronym Description 

PSK Phase Shift Keying 

QPSK Offset Quadrature Phase Shift Keying 

RDMS Receiver DeModulator Synchronizer 

RF Radio Frequency 

RJ-45 Ethernet Connection Jack 

RM Rack-Mount 

RRC Remote RDMS Client 

RS-232 Recommended Standard 232 (Serial Communications) 

SAW Sawtooth Wave 

SDI System Degradation Indication 

SNR Signal to Noise Ratio 

SOQPSK Shaped Offset Quadrature Phase Shift Keying 

SOQPSK-TG 
Shaped Offset Quadrature Phase Shift Keying –Telemetry 
Group 

TRL Tracking Loop 

TTL Transistor Transistor Logic 

UDP User Datagram Protocol 

UQPSK Unbalanced Quadrature Phase Shift Keying 

USB Universal Serial Bus 

VAC Voltage Alternating Current  

WAN Wide Area Network 
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